CiM Ex. 1051 Page 1



John Walkenbach

_Hi.mr’y Minds~

Best-Seliing Books - Dightal Downloads - e-Books - Answer Networks - e-Newslettars - Branded Web Sites - e-Leaming

New York, NY & Ceveland, O @ Indisnapolis, iN
i
&
£

CiM Ex. 1051 Page 2



Microseft” Excel 2000 Bikle

FPublished by

Hungry Minds, Inc,

09 Third Avenue

Mew York, NY 10022

WwW , Bungryn e ]

Copyright @ 1999 Hungry Minds, {nc. All rights
reserved. Mo part of this book, inchuding interior
design, cover design, and icons, may be repreduced
or transmitied in any form, by any means {clectronic,
phetocopying, recording, or otherwise) without the
prior written permissien of the publisher

Library of Congress Catalog Card Number; 98-753749
ISKIN: 0-7645-3255-6

Printed in the United States of America

109876

1B/RV/QW/OR/IN

Bistributed in the United States by Hungry Minds, Inc
Distributed by ¢
Transworld Publishers Limited in the United kmgﬁcm;
by D4 Norge Books for Norway; by 136 Sweden
Books {or Sweden; by IDG Books Australia Publishing
Corporation Pty. Ltd. for Australia and New Zealand,
by TransQuest Publishers Pte Ltd. for Singapore,
Malaysia, Thalland, Indonesia, and Hong Kong; by
Gotop Information Inc. for Taiwan; by ICG Muse, Inc.
for Japan; wy Intersoft for South Africa; by Eyrolles
for France: by International Thowmson Publishing for
Germany, Austria and Switzertand; by Distrimuidora
Cuspide for Argentina; by LR lnternational for Brazil;
by Galiles Libros for Chile; by Ediciones ZETA S.CR.
Lida. tor Peru; by WS Computer Publishing

CDG Books Canada Ing, for Canady; by

Corparation, lnc,, for the Philippines; by
Contemporanea de Ediciones for Yeneruela; by
Exmress Campurer Distributers for the Caribbean and
West lodies; by Micronesia Media Distributor, Ine dor
Micronesia; by Chips Computadoras 5.A. de CV. for
Mexico; by bditorial Nornma de Panama S A {or
Panama,; by American Bookshops for Finland.
For general information on Hangry Minds’ products
and services please contact our Customer Care
Department within the U.S. at 808-762-2874, outside
the U.S at 317-572-3993 or tax 317-572-4002.
For sales inquiries and reseller information, including
disconnts, premium and bulk quantity sales, and
forcign-language translations, please contact aur
Cuxiamer Care Departiaent at 800-434-3422, fax
-572-4802, or write to Hungry Mmds, inc., Attn:
Lusmmer Care Department, 10475 Crosspeint
Boulevard, Indianapolis, IN 46256,
For information on licensing foreign or domestic
rights, please contact sur Sub-Rights Customer Care
Department at 212-884-5000.
For anthorization to photocopy items for corporate,
personal, or eduacational use, please comtact
Copyright Clearance Center, 222 Rosewood Drive.
Danvers, MA 01923, or fax 9787504470,
For information on using Hungry Minds' products and
services in the classroom or for ordering examination
copics, please contact our Educational \aim
Department at 800-434-2086 or fax 317-572-4005,
Please contact our Public Relations Department at
212-884-5163 for press review copies or 212-884-5000
far author interviews and other publicity information
or fax 212-884-5400.

: THE PUBLISHER AND AUTHOR HAVE USED THEIR

BE‘ST E FPORTS iN P’REPARI’\G 1’1]!5 B()()K. 'I'HE PUBLISHER AND AUTHOR MAKE NO

4RI:PRE.§&N TATIONS OR WARRANTIES WITH RESPECT T0 THE ACCURACY OR COMPLETENESS OF THE
JCONTENTS OF THIS BOOK AND SPECIFICALLY DISCLAIS] ANY IMPLIED WARRANTIES OF
{MBRCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. THERE ARE NO WARRANTIES WHICH
IEXTEND BEYOND THE DESCRIPTIONS CONTAINED IN THIS PARAGRAPH. NO WARRANTY MAY BE
{CREATED OR EXTENDED BY SALES REPRESENTATIVES OR WRITTEN SALES MATERIALS. THE
{ACCURACY AND COMPLETENESS OF THE INFORMATION PROVIDED HERFIN AND THE OPINIONS
ISTATED HEREIN ARE SOT GUARANTEED OR WARRANTED TO PRODUCE ANY PARTICULAR RESULYS,

| AND THE ADVICE AND STRATEGIES CONTAINED HEREIN MAY NOT BE SUTTABLE FOR EVERY

HINDIVIDUAL.

NEITHER THE PUBLISHER NOR AUTHOR SHALL BE LIABLE FOR ANY LOSS OF PROFIT OR

{ANY OTHER COMMERCIAL DAMAGES, INCLUDING BUT NOT LIMITED TO SFECIAL, INCIDENTAL,
| CONSEQUENTIAL, OR OTHER DAMAGES. FULFILLMENT OF EACH COUPON OFFER 18 THE

| RESPONSIBILITY ®F THE OFFEROR.

Trademarks: Microsolt is a registered trademark of Microsoft

Corporation in the United States and/or other

countries. The MindSpring fogo is a trademark of MindSpring Enterprises, Inc, Netscape Communicator is a
trademark, and the Netscape N logo 1s a registered trademark of Netscape Cemmunicaticns Corporation in
the United States and other countries All Brand names and product names used in this book are trade names,
service marks, trademarks, or registered trademarks of their respective owners. Hungry Minds, Inc. is not
associated with any product or vendor mentioned in this book.

Hungry Minds- is a trademark of Hungry Minds, inc.

CiM Ex. 1051 Page 3



About the Author

Jokn Walkenbach is one of the country’s leading authorities on spreadsheet
software. He holds a Ph.D. from the University of Montana and has worked as an
instructor, programmer, and market research manager. He finally found a job he’s
good at: principal of JWalk and Associates Inc., a one-person San Diege-based
consulting firm that specializes in spreadsheet application development. John is
also a shareware developer, and his most popular product is the award-winning
Power Utility Pak add-in for Excel — which is used by thousands of people
throughout the world. John started writing ahout spreadsheets in 1984, and he
has since written more than 250 articles and reviews for publications such as

PC Warld, iInfoWorld, Windows magazine, and PC/Tomputing. In addition, he'’s

the author of a dozen other spreadsheet books, including Excei 2000 Power
Programming Techmigues, fixcel Programming for Dummies, and Excel 2000 For
Windows For Dumimies Quick Reference {all from DG Books Worldwide). In his
spare time, John enjoys digital photography and composing and playing music in
a variety of styles. John also maintains “The Spreadsheet Page” ou the Web. Pay
himavisit at http:/7www. j-walk.com,

CiM Ex. 1051 Page 4



Credits

Acquisitions Editer
David Mayhew

Development Editors
Tracy Brown

Valerie Perry

Kenvon Brown

Technical Editor
Bill Karow

Copy Editors
Anne Friedman
Biil McManus

Cover Design
Murder By Design

Production
Foster City Production Department

Proofreading and indexing
York Production Services

CiM Ex. 1051 Page 5



To VaRene

CiM Ex. 1051 Page 6



T

CiM Ex. 1051 Page 7



hanks for purchasing the Microsoft Excel 2000 Bible — vouy complete guide to a
i £ / b ¥ &
powertul and easy-to-use spreadsheet product.

i think that Excel 2000 is the best spreadsheet program on the market (frust me-—
I've used them all}). Excel has been around in various incarnations for almost a
decade, and each subsequent release pushes the spreadsheet envelope a bit
further —in some cases, a fof further. My goal in writing this book is to share with
yvou some of what | know about Excel, and in the process make you more efficient
on the job.

The book contains everything that you need to know o learn the basics of Excel
ang then move on to more advanced topics at vour own pace. You find many useful
exaraples as well as some of the tips and slick technigues that 've accumulated
over the years.

Is This Book for You?

The Bible series from DG Books Worldwide is designed for beginning, intermediate,
and advanced users, This book covers all the essential components of Excel and
provides clear and practical examples that vou can adapt to your own needs.

Excel can be used at many levels — from the simple to the extremely complex, I've
drawn a good balance here, focusing on the topics that are most useful 1o most
users, The following answers whether this book is for you:

Yes —{f vou have no spreadsheet experience

i vou're new to the world of spreadsheets, welcome to the fold, This book has
everything that you need to get started with Excel and then advance to other topics
as the need arises.

Yes - If you have used previous versions of Excel

I you've used Excel 97, vou're going to fesl right at hotne with Excel 2000. i you're
skipping a few upgrades and moving up from Excel § or Excel 95, yvou have lots to
iearn, because Microsoft has made many improvements in the past few years. in
any case, this book can get you up to speed quickly.
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Yes— if you have used Excel for the Macintosh

The Macintosh versions of Exce!l are very similar to the Windows versions, If you're
moving over from the Mac platform, you'll find some good background information
as well as specific details 1o make vour transition as smooth as possible.

Yes-—If vou have used DOS versions of 1-2-8 or Quatiro Pro

f yvou're abandoning a text-based spreadsheet such as 1-2-3 or Corel’s Quattro Pro
in favor of a more modern graphical product, this book can serve you well, You
have a head start, because you already know what spreadshests are all about, and
yvou'll discover some great new ways of doing things.

Yes — H you have used Windows versions of 1-2.3 or Quatiro Pro

If you've tried the other versions and are convinced that Exce] is the way to go,
this book quickly teaches you what Excel is all about and why it has such a great
reputation. Because you're already familiar with Windows and spreadsheets, you
can breeze through many introductory topics.

Software Versions

This book is written for Excel 2000 (also known as Excel 9), but much of the
information alsc applies to Excel 97, Excel 95, and Excel 5. I you use any version of
Excel prior to Version 5, be aware that the earlier versions are drastically different
from the current version,

Conventions Used in This Book

Take a minute to scan this section to learn some of the typographical conventions
that are used in this book.

Named Ranges and Your Input

Input that you type from the keyboard appears in bold. Named ranges may appear
in a code font. Lengthy input usually appears on a separate line, For instance, | may
instruct you to enter a formula such as the following:

="Part MName: " LYLOOKUP{PartNumber,Partilist,2)
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Key Names

Names of the keys on your keyboard appear in normal type. When two keys should
be pressed simultaneously, they are connected with a plus sign, like this: Press
Alt+E to select the Edit moenu. Here are the key names as { refer to them in the book:

Alt down arrow  MNum Lock right arrow

Backspace End Pause Scroll Lock

Caps Lock Home PgDn Shift

Ctrl Insert Pglp Tab

Delets left arrow Print Screen  up arrow
Functions

Excel’s built-int worksheet functions appear in uppercase, like this: Enter a SUM
formula in cell 20,

Mouse Conventions

lassume that you're using a mouse or some other pointing device, You come across
some of the following mouse-related terms:

+ Mouse pointer: The small graphic figure that moves onscreen when vou
move your mouse. The mouse pointer is usually an arrow, but it changes
shape when you move to certain areas of the scresn or when you're
performing certain actions.

+ Point: Move the mouse so that the mouse pointer is on a specific item, For
exampie, “Point to the Save button on thetoalbar”

+ Press: Press the left-mouse button once and keep it pressed. Normally, this is
used when dragging.

# Click: Press the left mouse button once and release it immediately.

+ Right-click: Press the right-mouse button once and release it immediately,
The right-mouse button is used in Excel 1o pop up shortcut menus that are
appropriate for whatever is currently selected.

4 Double-click: Press the left-mouse buftton twice in rapid suceession. i vour
double-clicking doesn’t seem to be working, you can adjust the double-click
sensitivity by using the Windows Control Panel icon.

4+ Drag: Press the left-mouse button and keep it pressed while you move the
mouse. Dragging is often used to select a range of cells or to change the size
of an object.

¢
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What the Icons Mean

Throughout the book, vou see special graphic symbols, or icons, in the left margin,
These call vour attention to points that are particularly important or relevant to a
specific group of readers. The icons in this book are as follows:

This symbo! denctes features that are new to Excel 2000,

This icon signals the fact that something is importani or worth noting. This may
alert you to @ concept that helps you to master the task at hand, or it may denote
something that is fundamental to understanding subsequent material.

This icon marks a more efficient way of doing something that may not be obvious.

This indicates that the material uses an example file located on this book’s com-
panion CO-ROM.

t use this symbol when there is a possibility that the operation I'm describing
could cause problems if you're not careful.

This icon indicates that a related topic is discussed elsewhere in this book.

How This Book Is Organized

MNotice that the book is divided into six main parts, followed by four appendizes.

Part I: Getting Started — This part consists of three chapters that provide
background about Excel. Chapter 2 describes the new features in Excel 2000,
Chapter 3 is a hands-on guided tour of Excel, which gives new users an opporiunity
to get their feet wet immediately.

Part ii: introduciory Concepts— The chapters in Part Il cover the basic concepts
with which all Excel users should be familiar.

Part HIl: Advanced Features— This part consists of six chapters dealing with
topics that are sometimes considered advanced. Many beginning and intermediate
users may find this information useful, as well.

Part IV: Analyzing Data— The broad topic of data analysis is the focus of the
chapters in Part IV, Users of all levels will find some of these chapters of interest.
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Fart V: Other Topics~— This part consists of three chapters that didn’t guite fit inio
anv other part. The chapters deal with using Excel with other applications, auditing
and proofing your work, and exploring the fun side of Excel { yes, Excel does have a
fun side).

Part VI: Customizing Excel - Part Vi is for those who want to customize Excel for
their own use or who are designing workbooks or add-ins that are t¢ be used by
others. It’s a good intreduction to Visual Basic for Applications { VBA),

Appendixes— The appendixes consist of supplemental and reference material that
may be useful to you,

How to Use This Book

This book is not intended to be read cover to cover. Rather, it's a reference book
that you can consult when:

4 You're stuck while trying to do something.
4+ You need to do something that yow've never done before.

4+ You have some thine on your hands, and you're interested in learning
something new.

The index is quite comprehensive, and each chapter typically focuses on a single
broad topic. If you're just starting out with Excel, 1 recommend that you read the
first three chapiers to gain a basic understanding of the product, and then do some
experimenting on yvour own. After vou've become {amiliar with Excel’s environment,
you can refer to the chapters that interest you the most. Some users, however, may
prefer to follow the chapters in order. Part Il is designed with these users in mind,

Don't be discouraged if some of the material is over vour head. Most users get by
just fine using only a small subset of Excel’s total capabilities. In fact, the 80/20 rule
applies here: 80 percent of Excel users use only 20 percent of its features. However,
using only 20 percent of Excel’s {features still gives you lofs of power at your
fingertips.

About the CD-ROM

You'll find that my writing style emphasizes examples. | know that 1 learn more

from a well-thought-out example than from reading a dozen pages, I've found that
this is true for many other people. Consequently, I spent a lot of time developing the
examples in this book. These exainple files are avallable on the companion CO-ROM.

Appendix D describes the material on the CD-ROM.

|
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Power Utility Pak Coupon

Toward the back of the book, vou'll find a coupon that you can redeem for a copy
of my Power Utility Pak software -— a collection of useful Excel utilities and new
worksheet functions. This product normally sells for $39.95, but I'm making it
available to readers of this book for only $9.95, plus shipping and handling. |
developed this package by using VBA exclusively, and the complete source files
are also available for those who want to learn slick VBA techniques.

{ think that the Power Utility Pak is extremely useful in yvour day-to-day work with
Excel, and | urge you to take advantage of this offer.

Contacting the Author

I'm always happy to hear from readers of my books. The best way to contact me is
by e-nail at the following Internet address:

John@j -wal <. com

I get lots of e-mail, s0 1 can’t promise a personal reply.

Visit “The Spreadsheet Page”

For even more Information on Fxcel, be sure to check out “The Spreadsheet Page”
on the World Wide Weh. The URL is:

Hotp:/ Jwwe . J-walk.com/ss/
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Thanks to everyone at IDG Books Worldwike who played a part in getting this book
into your hands. Especially, thanks to Tracy Brown and Valerie Perry; without their
able assistance, I'd still be pounding away at my kevboard.

Thanks also to all the people throughout the world who have taken the time to let
me know that my books have made an Impact. My goal is to write books that go
well beyond the material found in competing books. Based on the feedback that
Pve received, 1 think 'm succeeding. Writing software books may not be the most
glamorous job—but I can’t think of anything else I'd rather be doing.
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A Bit of
Background

Every book has to start somewhere. This chapter starts
from square one by introducing you to the concept of a
spreadsheet. Also included is a lot of interesting background
information about Excel and Windows.

What Is Excel?

Excel is a software product that falls into the general
category of spreadsheets. Excel is one of several spreadsheet
products that you ¢can run on your PC. Others include 1-2-3
and Quattro Pro.

A spreadsheet (including Excel) is a highly interactive
computer program that consists of a collection of rows and
columns displayed onscreen in a scrollable window. The
intersection of each row and column is called a cell, which
can hold a number, a text string, or a formula that performs
a calculation by using one or more other cells. Copying and
moving cells and modifying formulas is easy with a
spreadsheet.

A spreadsheet can be saved in a file for later use or discarded
after it has served its intended purpose. The cells in a
spreadsheet can be formatted in various ways and printed for
hard-copy reference. In addition, groups of numerical cells can
be used to generate charts and maps.

The most significant advantage of an electronic spreadsheet is
that the formulas recalculate their results if vou change any of
the cells that they use. As a result, after you set up your
spreadsheet by defining formulas, you can use this “model” to
explore different possibilities, with very little additional effort.
Excel is currently the best-selling Windows spreadsheet—and
[ hope to explain why in this book.
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The Evolution of Excel

Excel 2000 is actually Excel 9 in disguise.

A bit of rational thinking might lead you to think that this is the ninth version of
Excel. Think again! Microsoft may be a successful company, but its version-naming
techniques can be quite confusing. As you’ll see, Excel 2000 actually is the seventh
version of Excel.

Excel 2

Excel 2 was the original version of Excel for Windows, which first appeared in late
1987. It was labeled Version 2 to correspond to the Macintosh version, which was
the original Excel. Because Windows wasn’t in widespread use at the time, Version 2
included a run-time version of Windows —a special version with just enough
features to run Excel and nothing else. This version was quite crude by today’s
standards and was actually quite ugly.

Excel 3

At the end of 1990, Microsoft released Excel 3 for Windows. This was a significant
improvement in both appearance and features. It included toolbars, drawing
capabilities, worksheet outlining, add-in support, 3D charts, workgroup editing, and
lots more.

Excel 4

Excel 4 hit the streets in the spring of 1992. This version made quite an impact in
the marketplace, because Windows was becoming more popular. It had lots of new
features, many of which made it easier for beginners to get up to speed quickly.

Excel 5

In early 1994, Excel 5 appeared on the scene. This version introduced tons of new
features, including multisheet workbooks and the new Visual Basic for Applications
(VBA) macro language. Like its predecessor, Excel 5 took top honors in just about
every spreadsheet comparison that was published in the trade magazines.

Excel 7

Technically, this version was called Excel for Windows 95 (there was no Excel 6). It
began shipping in the summer of 1995. On the surface, this version wasn’t that

CiM Ex. 1051 Page 43



much different from Excel 5, and included only a few major new features. But Excel
7 was significant, because it was the first version to use the more advanced 32-bit
code. Excel 7 and Excel 5 used the same file format.

Excel 8

Excel 8 (officially known as Excel 97) was probably the most significant Excel
upgrade ever. The toolbars and menus had a great new look, anline help took a
dramatic step forward, and the number of rows available in a worksheet
quadrupled. Developers were pleased to discover that Excel’s programming
language (VBA) improved significantly in Excel 97.

Excel 9

Excel 9 (better known as Excel 2000) is the topic of this book (although most of the
material is also relevant to Excel 97). Excel 2000 has quite a few enhancements, but
its most significant advancement is the capability to use HTML as a standard file
format. Chapter 2 provides a list of all the new features in Excel 2000.

Excel's Competitors

Although Excel is usually considered the best spreadsheet available, it does have
competitors, the two main ones being 1-2-3 and Quattro Pro.

The three leading spreadsheets are similar in their basic capabilities. For example,
they all let you work with multiple worksheets in a single file; they all support a
wide variety of charts; and they all have macro capabilities to help you automate or
customize your work.

Many users, myself included, find that Excel is superior to the other products in
both power and ease of use.

What Excel Has to Offer

Excel is a feature-rich product that can be used at many different levels. Chances
are good that you won’t need all of Excel’s features, but you should become
generally farniliar with what they can do. Otherwise, you could seek another
software product to accomplish a particular task, and not even realize that Excel
has a feature that can accomplish it. Or, you could spend lots of time performing a
task manually that Excel can handle automatically.
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The following is a quick overview of what Excel can do for you. All of these topics
are discussed in subsequent chapters of this book.

Multisheet Files

Excel’s files (called workbooks) can consist of any number of separate sheets, and
you access these sheets by clicking a notebook-like tab. The sheets can be
worksheets or chart sheets. This feature makes organizing your work easy. For
example, you can keep all of vour budgeting spreadsheets in a single workbook.

Multiple Document Interface

Excel enables you to work with many files simultaneously; you don’t have to close a
file to consult another file (see Figure 1-1). This capability enables you to transfer
information easily between worksheets in different workbooks.

13813
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751
19184
TEG02
13578
16383
12328
1BETE
16265
20608
5558
18311
19155
5398 1
5362
811
1714
16205
18248
13089

HE R
Figure 1-1: Excel enables you to work with as many different files as you need.
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File Compatibility
Excel has its own file format, identifiable by the XLS file extension. In addition,

Excel can read files produced by other spreadsheet programs (such as 1-2-3 and
Quattro Pro), and it can read text files, dBASE files, and HTML documents.

Interactive Help

Computer documentation keeps getting better. In the past, users were lucky if the
manual that accompanied a software product accurately covered all the features.
Nowadays, the trend is away from written manuals and toward online help. Almost
all applications, including Excel, emphasize online help —in other words, you can
get help onscreen while working in Excel. Excel’s online help is excellent and
extremely detailed.

Figure 1-2 shows the Office Assistant, which serves several purposes, including:

= [t observes yvour actions and stores up a series of tips, which can save you
time. You can choose to view these tips whenever you want.

» It provides specific help with certain aspects of the program (for example,
creating charts).

* If you enter an invalid formula, it will often make a suggestion on how to
correct it.

» It provides an easy way to search for help on a particular topic. Just enter
your question in natural language, and the Office Assistant displays a list of
relevant help topics.

Easy-to-Use Features

Excel may well be the easiest-to-use spreadsheet available. It includes many
features designed specifically to make commonly performed tasks straightforward
and fast for both beginners and experts. The program walks you step by step
through several procedures, and basic editing and formatting commands are
intuitive and efficient. For example, a single dialog box enables you to change any
aspect of formatting for a cell or range, and right-clicking anything brings up a
context-sensitive shortcut menu.

List Management

Among Excel’s most significant strengths is how well it works with lists stored in a
worksheet. This feature makes it easy to sort, filter, summarize, and manipulate
data stored in your worksheet.
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The Office Assistant pops up to provide help when needed.

Built-in Functions

Excel includes an enormous collection of built-in functions that you can use in your
formulas. In addition to common functions, such as SUM and AVERAGE, you can
chaose functions that perform sophisticated operations that otherwise are difficult
or impossible to do. For example, the CORREL function calculates the correlation
coefficient for two sets of data. You also can develop other functions by using the
VBA macro language (it's not as difficult as yvou may think).

Customizable Toolbars

Excel’s toolbars — groups of buttons representing commands — are real time-savers,
enabling you to perform common commands without using the menu. You can
customize vour toolbars by adding buttons for tasks that you do most often. To find
out what a button does, drag the mouse over a toolbar button and pause for a
second. Excel pops up a brief description of the button.

Beginning with Excel 97, the menu bar at the top of the screen is actually a toolbar.
As such, you can easily customize it or even move it to a different location on the
screen.

Flexible Text Handling

Although Excel’s forte is number crunching, it's not too shabby at handling text.
You can format or orient text that you put in cells. You also can insert text boxes
(which you can move and resize) anywhere on your worksheet.
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Rich Text Formatting

Excel is the only spreadsheet that enables vou easily to format individual
characters within a cell. For example, if a cell contains text, you can make one letter
bold or a different color.

Great Charts

Excel’s charting features — among the best available in any spreadsheet —enable
you to modify and augment a wide assortment of graph types. You can insert a
chart anywhere in a worksheet or place it on a special chart sheet.

Integrated Mapping

Excel’s mapping feature lets you display your data in the form of a geographic map
(see Figure 1-3). For example, you can easily create an attractive map that shows
your company’s sales volume by state.

| Salas Maps.xls

California
Washington

| -

United States (AK & Hi Inset)
y ks Sakd

Easmw 12900 13)

Figure 1-3: This map was generated with only a few mouse clicks.

Drawing Tools

Excel includes an excellent set of drawing tools that enables yvou to create
attractive diagrams and basic drawings directly on your worksheet or chart. For
example, you can include a simple flow diagram along with your numerical analysis.
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Worksheet Qutlining

Spreadsheet outlining enables you to collapse hierarchical information to show any
level of detail. People who work with multilevel budgets will find this feature
particularly valuable.

Pivot Tables

A pivot table makes it easy to change how vou view a table of data. A pivot table
can quickly summarize a list or database, and you can use drag-and-drop
techniques to change the layout of the table. If you work with multidimensional
data, you should check out this powerful feature — which | consider to be one of
Excel’s major strengths.

Advanced Analytical Tools

Analytical types will be particularly excited about Excel’s unique array feature,
which enables you to do things that are impossible in other spreadsheets. Excel
also includes goal seeking, a powerful Solver feature, and the Analysis ToolPak
add-in, which provides extensive statistical, financial, engineering, and scientific
functions and procedures.

Flexible Printing and Print Preview

When you are ready to put your work on paper, you’ll be pleased to see how easy it
is. Besides normal WYSIWYG (What You See Is What You Get) formatting, Excel
provides a handy print preview feature. From the preview window, you can easily
make last-minute adjustments, including new column widths and margins. In
addition, a Page Break Preview mode lets you adjust the page breaks by using
simple dragging techniques.

Worksheet Auditing and Annotation

No one’s perfect, but Excel can help you get closer to that goal. Excel provides a
variety of auditing tools to help you track down errors and potential errors in your
worksheet formulas.

A feature in Excel automatically displays comments attached to cells when the user

drags the mouse over a cell that contains a comment. This is an excellent way to
remind others (or yourself) what a particular cell represents.
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Scenario Management

Spreadsheets are often used for what-if analysis— change one or more assumptions
and observe the effects on dependent formulas. Excel simplifies this process with
its scenario manager.

You can name scenarios, switch among scenarios (with just a few mouse clicks),
and generate reports that summarize the results of vour scenarios.

Spell Checking and AutoCorrect

An integrated spell checker spots spelling errors in your worksheets and charts, so
you need never again display a chart titled “Bugdet Review” in a crowded
boardroom.

Excel has borrowed a handy feature, AutoCorrect, from Microsoft Word. This
corrects many types of input errors as you type. For example, if you enter BUdget
into a cell, Excel automatically changes the second letter to a lowercase u. You can
also use this feature to develop your own shorthand. For example, you can instruct
Excel to replace IWC with International Widget Corporation.

Templates

If your work tends to fall into a few specific categories, it may be worth your time to
set up custom spreadsheet templates, which are preconfigured shells that include
text, row, and column headings, as well as formats, column widths, macros, and so
on. You can use these templates to help create similar spreadsheets.

Excel has a Template Wizard that walks you through the steps required to create a
custom template. Excel also includes a few handy templates that you may find
useful. An example of such a template is shown in Figure 1-4.

Database Management

You can work with spreadsheet data as if Excel were a database. Excel features all
the standard database commands and enables you to work with databases that are
stored in external files.

XLM Macro Compatibility

In older versions of Excel, you could create macros by using special macro
functions in XLM documents. Although Visual Basic for Applications is a much
better macro language, Excel 2000 still supports XLM macros. This means that you
can continue to run macros that were developed for older versions of Excel (Excel 4
and earlier).
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Figure 1-4: Expense Statement1 is one of several templates included with
Excel 2000.

Visual Basic for Applications (VBA)

VBA is a powerful programming language that is built right into Excel (as well as
several other Microsoft products). After you learn VBA’s ropes, you can do magic
with yvour Excel workbooks.

Custom Dialog Boxes

Excel makes it very easy to create custom dialog boxes (also known as user forms).
Custom dialog boxes usually are used in conjunction with VBA macros that yvou
write.

Worksheet Controls

With Excel, you can insert functional “dialog box” controls (such as buttons,
scrollbars, list boxes, and check boxes) directly on vour worksheet. You can even
link these controls to cells without using macros. Figure 1-5 shows an example of
such controls.
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Figure 1-5: You can add functional controls, such as
buttons, scrollbars, list and check boxes, directly to
your worksheet to make it easier to use.

Protection Options

If vou need to keep others (or yourself) from modifying your worksheet, vou'll find
that Excel offers a variety of protection techniques. For example, you can protect
cells that contain formulas, to eliminate the possibility of accidentally deleting an
important formula.

Add-In Capability

Excel supports add-ins — a feature that lets you enhance the program’s
functionality. Excel includes several add-ins, and you can use VBA to create your
own add-ins.

OLE Support

Excel supports Microsoft’s Object Linking and Embedding (OLE) technology, which
makes data sharing easier than ever. For example, you can embed a Word for
Windows document in a worksheet and then access all of the features of Word right
in your worksheet.
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Internet Support

Excel 2000 includes a variety of features that make it easy to access Internet
documents, save and retrieve documents stored in HTML format, and create
hyperlinks directly in your spreadsheet documents.

Cross-Platform Consistency

Excel runs on the Macintosh and the PC (in Windows); in fact, the versions are very
similar across the two platforms. If you learn the Windows version, you can move
to a Mac and feel right at home.

Summary

This chapter introduces the concept of a spreadsheet, presents a brief history of
Excel, and examines Excel’s evolution within the Microsoft environment. The bulk
of the chapter provides an overview of Excel’s key features —all of which are
covered in subsequent chapters.
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What's New in
Excel 2000?

Every new release of Excel is a big event for Excel fans,
and Excel 2000 is certainly no exception. Although it
doesn’t add too many new features (compared to Excel 97),
it's by far the best version yet. In this chapter I provide an
overview of what’s new, what’s gone, and what’s changed
compared to Excel 97.

Installation Improvements

If you've installed previous versions of Excel, vou'll notice that
Excel 2000 provides a new “intelligent” installation wizard. If
you have a previous version installed, you’ll get a choice to
petform either a similar install or a standard installation. [If
you choose the former, all of vour previous settings will be
transferred to Excel 2000.

You also have quite a bit more flexibility in selecting which
features to install. Even if you omit a few key features during
the intial installation, they will still appear on the menus, If
you attempt to access an uninstalled component, you’ll get a
prompt asking you if you want to install it. Even better, if your
installation somehow gets messed up—a critical file gets
deleted, for example — the new self-repair feature will detect
that fact and re-install the missing file.
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New Internet Features

Most of the new features in Excel 2000 deal with the Intemet.

« HTML file format: If you like, vou can use HTML as a “native” file format for
your Excel work. In other words, you can save a workbook as an HTML file
and then re-open it without losing anything. Unless your work needs to be on
a corporate intranet, you're much better off sticking with the normal XLS
format.

* Save to a server: Excel 2000 makes it very easy to save a workbook directly
to an intranet or an ISP host. In fact, if the server is running Microsoft’s
FrontPage Server Extensions, it's as easy as saving to a local or network
drive. If end users are running Internet Explorer 4.0 or a later version, they
can manipulate Excel data (for example, pivot tables, charts, and
worksheets) within the browser.

* Web discussions: Use the Discussion toolbar to insert and navigate between
comments. You can create discussions about the document, or online
discussions specific to a paragraph. You can reply, edit, or delete from a
right-clicked context menu. Comments are indented as in the threaded
discussion model common on the Internet, and are threaded with the
contributor’s name, date, and time stamp.

»  Web subscription and notification: This lets you configure documents and
folders to trigger e-mail or Internet Explorer channel updates when a document
or related discussion is added, changed, or deleted. You can set notification as
daily, weekly, or “within a few minutes.” The message provides the date and
time, the name of the editor, the document’s URL, and a link you can click to
cancel further notifications. New comments and replies to remote documents
are tracked, but you can’t subscribe to e-mail updates on the remote docu-
ments and folders themselves.

| discuss these features in Chapter 30.

New File Dialog Boxes

The dialog boxes that are displayed when you select File« Save or File« Open have
been redesigned so you can see mare files at one time and access them more
quickly. You can use the icons in the new “Look in” bar along the left side to get to
the folders and locations you use the most. Click the History icon to see the last
20-50 documents and folders you have worked with, and then click the Back button
to easily return to folders you have recently visited.
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PivotTable Enhancements

Excel’s PivotTable feature is an extremely useful tool for summarizing data. Excel
2000 adds some new twists:

» Streamlined PivotTable Wizard: Creating pivot tables is faster than ever. The
new PivotTable toolbar displays the file names, and you can simply drag them
to your pivot table.

» PivotChart: Pivot tables can also now be charted. PivotChart dynamic views
are linked to PivotTable.

Automatic Formula Adjustment

Excel 2000 will automatically adjust formulas when you insert a new row directly
above the formula. For example, assume you have the following formula in cell A5,
which sums the values in A1:A4:

=SUMCAL:A4)

If you insert a new row directly above row 5 and enter a value into cell A5, the
formula adjusts automatically to:

=SUMCAL:AD)

In most cases, automatic formula adjustment is exactly what you want. In other
cases, however, this can cause the formula to display an incorrect result.

See-Through Cell Selection

A common complaint among Excel users has been the fact that selecting a cell or
range obscures the colors in the cells. Excel 2000 finally addresses that complaint,
and now uses a different way of highlighting selected ranges. Now you can still see
the colors when you select a range.

Personalized Menus

In an attempt to simplify your life, Excel 2000 is capable of adjusting its menus to
your work habits. It does so by displayving only the menu items yvou use most
frequently. You still have access to all commands, of course. At the bottom of the
drop-down menu are arrows that can be clicked open to reveal additional menu
choices.
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Over time, Excel will learn which application features you use most often and then
display them higher on the menu list. Less commonly used features are demoted
and eventually disappear.

Although some users may see this as a usability enhancement, | think moving the
menu commands around is bound to cause confusion. Fortunately, you can turn
this feature off. Select View+ Toolbars+ Customize, then click the Options tab.
Remove the checkmark from the option labeled Menus show recently used
commands first.

Easier Toolbar Customization

Excel, of course, is big on toolbars. If you find that you never use some of the
buttons on a particular toolbar, it's very easy to remove them. Toolbars now have a
small down-pointing arrow button that, when clicked, displays a button labeled Add
or Remove Buttons. Click this button to reveal a list of buttons in the toolbar (see
Figure 2-1). Simply remove the checkmark to hide a button.

Figure 2-1: Excel 2000 makes it very easy to customize
toolbars by showing only the buttons you need.

Documents on the Windows Taskbar

If you use Windows 98, each Excel document appears as a separate task in the
Windows taskbar.

Enhanced Clipboard

Excel 2000 (along with the other members of Office 2000) uses a special Office
clipboard. This enhanced clipboard supports a feature known as “collect and
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paste” —the ability to store information from several sources and then selectively
paste it to a new location.

The Clipboard toolbar (see Figure 2-2) displays icons for each item copied.
Unfortunately, this enhanced clipboard only works with the Office applications.

Figure 2-2: Excel 2000 lets you
store up to 12 separate items on
a special enhanced clipboard.

Euro Currency Symbol

Additional number formats are available with the Euro currency symbol.

New Image Import Options

Excel 2000 lets you import an image directly from a digital camera or scanner. It’s
no longer necessary to capture the image to a file and then import the file.

A New Help System

Online help in Excel 2000 sports a new look. Microsoft abandoned the traditional
Windows help system in favor of a new “HTML Help” system. The system works
pretty much like the old one. By default, the help display appears along side of Excel.

For more information about Excel’s online help system, refer to Appendix A.

Office Assistant

The Office Assistant, which debuted in Excel 97, makes an appearance in Excel 2000.
I've found that people either love this feature or hate it (I'm in the latter group).

The Office Assistant is a bit less obtrusive in Excel 97 and (finally!) it ¢an be

configured in such a way that you never see it again (unless you want to). When
you install Excel 2000, there is an option to omit the Office Assistant feature.
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Multilingual Features

Multilingual users should have it a bit easier with Excel 2000. Excel 2000 can
change the language used in its interface (the text in menus, dialog boxes, and so
on) on the fly. Doing so is as easy as purchasing the Office language pack. Excel
automatically detects the language you're typing in and switches among spelling
checker, AutoCorrect, and other proofing tools accordingly.

Modeless UserForms

Finally, macro programmers will welcome a new feature that lets you display
custom dialog boxes (UserForms) in a “modeless” manner. In previous versions,
everything ground to a halt while a custom dialog box was displayed. In Excel 2000,
a macro programmer can keep the dialog box displayed while the user continues
working — perfect for displaying status information.

Summary
This chapter provides a brief overview of the new features in Excel 2000.

 SENEESLUES  SREENIIRES
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Getting
Acquainted
with Excel

N ew users sometimes are overwhelmed when they first
fire up Excel. They're greeted with an empty workbook,
lots of strange buttons, and unfamiliar commands on the
menus. This chapter helps you to feel more at home with
Excel, explains its main parts, and gives you a chance todo a
few things to get better acquainted with it.

Starting Excel

Before yvou can use Excel, it must be installed on your system.
And before you can install Excel, Microsoft Windows must be
installed on your system. Excel 2000 requires a 32-bit
operating system, such as Windows 95, Windows 98, or
Windows NT. With any luck, Excel is already installed and
ready to rumn. If not, you need to run the Setup program on the
Office 2000 CD-ROM.

Excel’s Parts

When Excel starts, your screen looks something like Figure
3-1. This figure identifies the major parts of Excel’s window,
which are explained in the following paragraphs.
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Window Control Menu Button

This button is actually Excel’s icon. When vou click it, vou get a menu that lets you
manipulate Excel's window.

Minimize Button

Clicking this button minimizes Excel’s window and displays it in the Windows
taskbar.

Restore Button

Clicking this button “unmaxirnizes” Excel’s window so that it no longer fills the
entire screen. If Excel isn’t maximized, this button is replaced by a Maximize
button.

Close Button

Clicking this button closes Excel. If you have any unsaved files, you're prompted to
save them.

Menu Bar

This is Excel’s main menu. Clicking a word on the menu drops down a list of menu
items, which is one way for vou to issue a command to Excel.

The menu bar in Excel 2000 is not fixed in place. In fact, it’s actually a toolbar. You
can drag it to any side of the window or even make it free-floating if you like.

Toolbars

The toolbars hold buttons that yvou click to issue commands to Excel. Some of the
buttons expand to show additional buttons or commands.

Formula Bar

When you enter information or formulas into Excel, they appear in this line.
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Name Box

This box displays the name of the active cell in the current workbook. When vou
click the arrow, the list drops down to display all named cells and named ranges (if
any) in the active workbook. Select a name to activate the range or cell. You also
can use the Name box to name the selected cell or range.

The Name box also displays the name of a selected object, such as a chart or
drawing object. However, you cannot use the Name box to select an object
or change the name of an object.

Status Bar

This bar displays various messages, as well as the status of the Num Lock, Caps
Lock, and Scroll Lock keys on your kevhoard.

Parts of a Workbook Window

When you work with Excel, your work is stored in workbooks. Each workbook
appears in a separate window within Excel’s workspace.

Figure 3-2 shows a typical workbook window with its major parts identified. These

parts are described in the following paragraphs. Notice that a workbook window
has many parts in common with Excel’'s window.

Title Bar

The title bar shows the name of the workbook and holds some control buttons that
you can use to modify the window.

Window Control Menu Button

Clicking this button (actually an icon) displays a menu that lets you manipulate the
workbook window.

Minimize Button

Clicking this button reduces the workbook window so that only the title bar shows.
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Select All Button

Clicking the intersection of the row and column headers selects all cells on the
active worksheet of the active window.

Active Cell Indicator

This dark outline indicates the currently active cell (one of the 16,777,216 cells on
each worksheet).

Row Headings

Numbers ranging from 1 to 65,536 — one for each row in the worksheet. You can
click a row heading to select an entire row of cells.

Column Headings

Letters ranging from A to [V—one for each of the 256 columns in the worksheet.
After column Z comes column AA, which is followed by AB, AC, and so on. After
column AZ comes BA, BB, and so on until you get to the last column, labeled IV.
You can click a colunm heading to select an entire column of cells.

Tab Scroll Buttons

These buttons let you scroll the sheet tabs to display tabs that aren’t visible.

Sheet Tabs

Each of these notebook-like tabs represents a different sheet in the workbook. A
workbook can have any number of sheets, and each sheet has its name displaved in
a sheet tab. By default, each new workbook that vou create contains three sheets.

Tab Split Bar

This bar enables you to increase or decrease the area devoted to displaying sheet
tabs. When you show more sheet tabs, the horizontal scrollbar’s size is reduced.

Horizontal Scrollbar

Allows you ta scroll the sheet horizontally.
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Vertical Scrollbar

Lets vou scroll the sheet vertically.

[f you have a Microsoft IntelliMouse, you can use the mouse wheel to scroll
vertically.

A Hands-on Excel Session

The remainder of this chapter consists of an introductory session with Excel. [f
you've never used Excel, vou may want to follow along on your computer to get a
feel for how this program works.

The end result of this hands-on session is available on the companion CD-ROM.

" This example assumes that you've been asked to prepare a one-page report that
shows your company’s quarterly sales, broken down by the two sales regions
{North and South). This section walks you through the steps required to do the
following:

» Enter a table of data (the sales figures) into a worksheet

» Create and copy a formula (to calculate totals)

* Format the data so that it looks good

= Create a chart from the data

» Save the workbook to afile

» Print the data and chart (the one-page report)

When vou're finished, you’ll have a worksheet that looks like the one shown in
Figure 3-3.

This section is quite detailed and provides every step that you need to reproduce
the worksheet shown in Figure 3-3. If you already have experience with a spread-
sheet, you may find this section to be a bit too detailed. Don"t worry. You'll find
that the pace picks up in the remainder of the book.

Getting Ready

As a first stage, you start Excel and maximize its window to fill the entire screen.
Then you maximize the blank workbook named Bookl.
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Figure 3-3: This is the worksheet that you create in the step-by-step session.

1. If Excel isn’t running, start it. You're greeted with a blank window named
Bookl. If Excel is already running, click its Close button to exit Excel and then
restart it so that you see the empty window named Bookl.

2, If Excel doesn’t fill the entire screen, maximize Excel’s window by clicking the
Maximize button in Excel’s title bar.

3. Maximize the workbook window, so that you can see as much of the workbook
as possible. Do this by clicking the Maximize button in Bookl’s title bar.

Entering the Headings

In this stage, you enter the row and column headings into the worksheet named
Sheetl in Bookl. After you finish the following steps, the worksheet will look like
Figure 3-4.
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Figure 3-4: The worksheet after entering headings for the data.

1. Move the cell pointer to cell A3 by using the direction keys. The Name box
displays the cell’s address.

2, Enter North into cell A3. Just type the text and then press Enter. Depending on
vour setup, Excel either moves the cell pointer down to cell A4 or the pointer
remains in cell A3.

3. Move the cell pointer to cell A4, type South, and press Enter.
4, Move the cell pointer to cell Ab, type Total, and press Enter.
5. Move the cell pointer ta cell B2, type Quarter 1, and press Enter.

At this point, you could enter the other three headings manually, but let Excel
do the work instead.

6. Move the cell pointer to cell B2 {if it's not already there). Notice the small
square at the lower-right corner of the cell pointer. This is called the £fill
handle. When vou move the mouse pointer over the fill handle, the mouse
pointer changes to a dark cross.
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If the cell doesn’t have a fill handle, select the Tools+ Options command and
then click the Edit tab in the Options dialog box. Place a check mark next to
the option labeled Allow cell drag and drop. Then click OK to close the
Options dialog box.

7. Move the mouse pointer to the fill handle until the mouse pointer changes to
a cross. Then click and drag to the right until you select the three cells to the
right (C2, C3, and C4). Release the mouse button and you’'ll see that Excel
filled in the three remaining headings for you. This is an example of AutoFill.

Entering the Data

In this stage, you simply enter the values for each quarter in each region.

1. Move the cell pointer to cell B3, type 123, and press Enter.

2, Move to the remaining cells and enter additional data until your worksheet
looks like Figure 3-5.

R s

Figure 3-5: The worksheet after entering the sales data.
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Creating a Formula

So far, what you've done has been fairly mundane. In fact, vou could accomplish the
same effect with any word processor. In this stage, you take advantage of the power
feature of a spreadsheet: formulas. You create formulas to calculate the total for
each region.

1. Move the cell pointer to cell B5.

2. Locate the AutoSum button on the toolbar helow the menu and click it once.
The AutoSum button has a Greek sigma on it. The toolbar below the menu is
called the Standard toolbar. Notice that Excel inserts the following into the
cell:

=SUM(B3:B4)

This is a formula that calculates the sum of the values in the range B3
through B4.

3. Because this formula is exactly what vou want (Excel guessed correctly),
press Enter to accept the formula. You see that the sum of the two values is
displayed in the cell. You could repeat this step for the remaining three
quarters, but it’s much easier to copy the formula to the three cells to the
right.

4, Move the cell pointer to cell B5 (if it’s not already there).

5. Move the mouse pointer to the fill handle. When it changes to a cross, click
and drag three cells to the right. Release the mouse button and you'll see that
Excel copied the formula to the cells that you selected.

At this point, your worksheet should look like Figure 3-6. To demonstrate that these
are actual “live” formulas, try changing one or two of the values in rows 3 or 4.
You’'ll see that the cells with the formulas change also. In other words, the formulas
are recalculating and displaying new results using the modified data.

Formatting the Table

The table looks fine, but it could look even better. In this stage, vou use Excel’s
automatic formatting feature to spiff up the table a bit.

1. Move the cell pointer to any cell in the table (it doesn’t matter which one
because Excel will figure out that table’s boundaries).

2. Click the Format menu; it drops down to display its menu items.
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Figure 3-6: The worksheet after inserting a formula and copying it.

3. Select AutoFormat from the list of menu items. Two things happen: Excel
determines the table boundaries and highlights the entire table, and it
displays the AutoFormat dialog box. Figure 3-7 shows how this looks.

4. The AutoFormat dialog box has 16 “canned” formats from which to choose.
Click the table format that you want to apply; this example uses Classic 3.

5. Click the OK button. Excel applies the formats to your table.

Your worksheet should look similar to Figure 3-8.
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Figure 3-7: Excel’s AutoFormat dialog box makes it easy to quickly format a table.

Note that Excel automatically made the following formatting changes for you:

* It changed some of the cell background colors
« It changed some of the cell foreground colors
» [t made the column headings italic
» It made the row labels bold
» It added borders
You could have performed all of these formatting operations yourself, but it

probably would have taken several minutes. The AutoFormat feature can save you
lots of time.
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Figure 3-8: Your worksheet after applying automatic formatting.

Adding a Title

In this stage, you add a title to the table, make the title bold, and adjust it so that
it's centered across the five columns of the table.

1. Move the cell pointer to cell Al.

2, Enter Sales by Region and then press Enter.

3. Move the cell pointer back to cell Al (il it’s not there already) and then click
the Bold button on the Formatting toolbar (the Bold button has a large B).
This makes the text bold.

4, Open the Font Size list box (see Figure 3-9) on the Formatting toolbar and
select 14 from the list, to make the text larger.

5. Click in cell Al and drag to the right until you select Al, B1, C1, DI, and El
(that is, the range AL:EL). Don’t drag the cell’s fill handle. You want to select
the cells —not make a copy of cell Al.
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1. Move the cell pointer to cell A2,

2. Click and drag until you've selected all the cells in the rectangle
encompassing A2 at the upper left and E4 at the lower right (15 cells in all).
Notice that you're not selecting the cells in the row that displays the tatals;
you don’t want the totals to appear in the chart.

3. With the range A2:E4 selected, click the Chart Wizard button on the Standard
toolbar (the Chart Wizard button has an image of a column chart). Excel
displays the Office Assistant, which offers you help with charting, and the first
in a series of dialog boxes that will help you create the chart that you want
(refer to Figure 3-11).

Figure 3-11: The first of four Chart Wizard
dialog boxes that help you create a chart.

4. First, choose the chart type. The default chart, a Column chart, is a good
choice for the data in the workbook. At this point, vou can either click the
Next button and specify lots of additional options for the chart or click Finish
and accept all of Excel’s default choices. Click the Finish button.

Excel creates the chart and displays it on the worksheet. It also displays its Chart

toolbar, just in case you want to modify the chart. To get rid of the toolbar, just
click the X in its title bar. Your worksheet should look like Figure 3-12.
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Figure 3-12: The Chart Wizard inserts the chart on the w

{8

orksheet.

If you want, you can do the following:
* Resize the chart by dragging anv of the eight handles on its borders (the
handles appear only when the chart is selected)

* Move the chart by clicking and dragging any of its borders

Saving the Workbook

Until now, everything that you've done has occurred in your computer’s memory.
If the power should fail, all would be lost, so it’s time to save vour work to a file.
Call this workbook My first workbook.

1. Click the Save button on the Standard toolbar. The Save button looks like a
disk. Excel responds with the Save As dialog box (see Figure 3-13).

2. In the box labeled File name, enter My first workbook and then either click
Save or press Enter.
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Figure 3-13: Excel’s Save As dialog box.

Excel saves the workbook as a file. The workbook remains open so that you can
work with it some more.

Printing the Report

As the final step, you print this report, assuming that you have a printer attached
and that it works properly. To print the worksheet, just click the Print button on the
Standard toolbar (this button has an image of a printer on it). The worksheet
(including the chart) is printed using the default settings.

Quitting Excel

Click the Close button in Excel’s title bar to exit Excel. Because no changes were
made to the workbook since it was last saved, Excel closes without asking whether
you want to save the file.

Summary

If this was your first time using Excel, you probably have lots of questions about
what you just did in the preceding exercise. Those questions are answered in the
following chapters.
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If you're the adventurous type, you may have answered some of vour own
questions by trying out various buttons or menu items. It so, cangratulations!
Experimenting is the best way to get to know Excel. Just remember, the worst thing
that can happen is that vou mess up a workbook file. And if you do your
experimentation using unimportant files, you have absolutely nothing to lose. And,
don’t forget about the Office Assistant. You can click the Office Assistant at any
time and type a question (using natural language). Your chances are excellent that
the Assistant will steer vou to a help topic that answers your question.
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Navigating
Through Excel

Because you'll spend lots of time working in Excel, you
need to understand the basics of navigating through
workbooks and how best to use Excel’s user interface. If
you're an experienced Windows user, some of this informa-
tion may already be familiar to vou, so this is your chance to
learn even more.

If vou're new to Excel, some of the information in this chapter
may seem confusing. It will become clearer as you progress
through the other chapters, however.

Working with Excel’s Windows

The files that Excel uses are known as workbooks. A workbook
can hold any number of sheets, and these sheets can be either
worksheets (a sheet consisting of rows and colurmns) or chart

sheets (a sheet that holds a single chart). A worksheet is what

people usually think of when they think of a spreadsheet.

Figure 4-1 shows Excel with four workbooks open, each in

a separate window. One of the windows is minimized and
appears near the top-right corner of the screen (when a work-
book is minimized, only its title bar is visible).

Worksheet windows can overlap so that the title bar of one
window is a different color. That’s the window that contains
the active workbook.

The workbook windows that Excel uses work much like the
windows in any other Windows program. Excel’s windows can
be in one of the following states:

» Maximized: Fills Excel’s entire workspace. A maximized
window does not have a title bar, and the worksheet’s
name appears in Excel’s title bar. To maximize a window,
click its Maximize button.
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« Minimized: Appears as a small window with only a title bar. To minimize
a window, click its Minimize button.

* Restored: A nonmaximized size. To restore a maximized or minimized
window, click its Restore button. lf you work with more than one workbook
simultaneously (which is quite common), you have to learn how to move,
resize, and switch among the workbook windows.

i
AL R

Figure 4-1: Excel with four workbooks open, one of them minimized.

As you're probably aware, Excel itself is contained in a window. Excel’s window also
can be maximized, minimized, or displayed in a nonmaximized size. When Excel’s
window is maximized, it fills the entire screen. You can activate other programs by
using the Windows taskbar (usually located at the bottom of your screen).

Moving and Resizing Windows

You cannot move or resize a workhook window if it is maximized. You can move
a minimized window, but doing so has no effect on its position when it is subse-
quently restored.

To move a window, click and drag its title bar with your mouse. Note that the win-
dows can extend offscreen in any direction, if vou want them to.
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To resize a window, click and drag any of its borders until it’s the size that you
want it to be. When you position the mouse pointer on a window’s border, the
mouse pointer changes shape, which lets you know that vou can now click and
drag to resize the window. To resize a window horizontally and vertically at the
same time, click and drag any of its corners.

If yvou want all of your workbook windows to be visible (that is, not obscured by
another window), vou can fiddle around by moving and resizing the windows manu-
ally, or you can let Excel do it for you. The Window+ Arrange command displays

the Arrange Windows dialog box, shown in Figure 4-2. This dialog box has four
window-arrangement options. Just select the one that you want and click OK.

Figure 4-2: The Arrange
Windows dialog box
makes it easy to arrange
the windows of all open
workbooks.

Switching Among Windows

As previously mentioned, at any given time, one (and only one) workhook window
is the active window. This is the window that accepts your input, and it is the win-
dow on which your commands work. The active window’s title bar is a different

color, and the window appears at the top of the stack of windows.

The following are several ways to make a different window the active workbook:

* Click another window, if it’s visible. The window you click moves to the top

and becomes the active window.

» Press Ctrl+Tab to cycle through all open windows until the window that vou
want to wark with appears on top as the active window. Shift+Ctrl+Tab cycles

through the windows in the opposite direction.

« Click the Window menu and select the window that you want from the bottom

part of the pull-down menu. The active window has a check mark next to

it, as

shown in Figure 4-3. This window can display up to nine windows. If you have

more than nine workbook windows open, choose More Windows (which
appears below the nine window names).

you want to view. This feature works only with Windows 98.

Excel 2000 offers another way to make a different window the active workbook:
Click the icon in the Windows taskbar that represents the workbook window that
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You also can display a single workbook in more than one window. For example, if
yvou have a workbook with two worksheets, you may want to display each worksheet
in a separate window. All the window-manipulation procedures described previously
still apply.

Closing Windows

When you close a workbook window, Excel checks whether you have made any
changes since the last time yvou saved the file. If not, the window closes without
a prompt from Excel. lf vou’ve made any changes, Excel prompts you to save the
file, before it closes the window.

You learn more about working with files in Chapter 5.

To close a window, simply click the Close button on the title bar.

Mouseless Window Manipulation

Although using a mouse to manipulate Excel’'s windows is usually the most efficient
route, you also can perform these actions by using the kevboard. Table 4-1 summa-
rizes the key combinations that manipulate workbook windows.

M

Key Combinatien Action

Ctri+Shift+F6

Ctrl+Shift+Tab Activate the previous window

Ctrl+F8 Resize a window*

* Use the direction keys to make the change, and then press Entet.
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Using the Keyboard

As you probably already know, you can use the standard navigational keys on your
keyboard to move around a worksheet. These keys work just as you would expect:
the down arrow moves the active cell down one row, the right arrow moves it one
column to the right, and so on. PgUp and PgDn move the active cell up or down
one full window (the actual number of rows moved depends on the number of rows
displayed in the window).

When you turn on Scroll Lock, you can scroll through the worksheet without
changing the active cell. This can be useful if you need to view ancther area of
your worksheet and then quickly return to your original location. Just press Scroll
Lock and then use the direction keys to scroll through the worksheet. When you
want to return to the original position (the active cell), press Ctrl+Backspace. Then,
press Scroll Lock again to turn it off. When Scroll Lock is turned on, Excel displays
SCRL in the status bar at the bottom of the window.

The Num Lock key on vour keyboard controls how the keys on the numeric keypad
behave. When Num Lock is on, Excel displays NUM in the status bar, and the keys
on your numeric keypad generate numbers. Most keyboards have a separate set of
navigational keys located to the left of the numeric keypad. These keys are not
affected by the state of the Num Lock key.

Table 4-2 summarizes all the worksheet movement keys available in Excel.

CiM Ex. 1051 Page 88



Right arrow Moves the active cell one column to the right

PgDn Moves the active cell down one screen

Alt+PgUp Moves the active cell left one screen

Up arrow™ Scrolls the screen up one row (active cell does not change)

Left arrow* Scrolls the saeen left one column (active cell does not change)

Wwith Scroll Lock on

The actions for some of the keys in the preceding table may be different, depending on
the transition options that you've set. Select Tools* Options and then click the
Transition tab in the Options dialog hox. If the Transition Navigation Keys option is
checked, the navigation keys correspond to those used in older versions of Lotus 1-2-3.
Generally, using the standard Excel navigation keys is better than using those for 1-2-3.

if you know either the cell address or the name of the cell that you want to acti-
vate, you can get there quickly by pressing F5 (the shortcut key for Edit- Go To).
This command displays the Go To dialog box.

Just enter the cell address in the Reference box (or choose a named cell from the
list), press Enter, and you're there.

Using a Mouse

Navigating through a worksheet with a mouse also works as you would expect it to
work. To change the active cell by using the mouse, click another cell; it becomes
the active cell. If the cell that you want to activate is not visible in the workbook
window, you can use the scrollbars to scroll the window in any direction. To scroll
one cell, click either of the arrows on the scrollbar. To scroll by a complete screen,
click either side of the scrollbar’s scroll box. You also can drag the scroll box for
faster scrolling. Working with the screllbars is more difficult to describe than to do,
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so if scrollbars are new to you,  urge you to experiment with them for a few
minutes. You'll have it figured out in no time.

When you drag the scrollbar’s scroll box, a small yellow box appears that tells you
which row or column yvou will scroll to when you release the mouse button.

If vou have a Microsoft IntelliMouse (or a compatible wheel mouse), you can use
the mouse wheel to scroll vertically. The wheel scrolls three lines per click at the
default rate. Also, if you click the wheel and move the mouse in any direction, the
worksheet scrolls automatically in that direction. The more you move the mouse,
the faster the scrolling. If you prefer to use the mouse wheel to zoom the work-
sheet, select Tools+ Options, click the General tab, and then place a check mark
next to the option labeled Zoom on roll with IntelliMouse.

Using the scrollbars or scrolling with the [ntelliMouse doesn’t change the active
cell. It simply scrolls the worksheet. To change the active cell, vou must click a new
cell after scrolling.

Notice that only the active workbook window has scrollbars. When you activate
a different window, the scrollbars appear.

Giving Commands to Excel

Excel is designed to take orders from you. You give these orders by issuing
commands. You can give commands to Excel by using the following methods:

» Menus

» Shortcut menus

+ Toolbar buttons

» Shortcut key combinations
[n many cases, you can choose how to issue a particular command. For example,
if you want to save your workbook to disk, you can use the menu (the File« Save
command), a shorteut menu (right-click the workbook’s title bar and click Save),

a toolbar button (the Save button on the Standard toolbar), or a shortcut key
combination (Ctrl+S). The particular method yvou use is up to you.

The following sections provide an overview of the four methods of issuing com-
mands to Excel.

Using Excel’s Menus

Excel, like all other Windows programs, has a menu bar located directly below the title
bar (see Figure 4-5). This menu bar is always available and ready for your command.
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Excel’s menus change, depending on what you're doing. For example, if vou’'re working
with a chart, Excel’s menus change to give you options that are appropriate for a
chart. This all happens automatically, so you don’t even have to think about it.

it il

Figure 4-5: Excel's menu bar displays different options, depending on the nature
of your task.

Technically, Excel 2000s menu bar is just another toolbar. In Excel 2000, toolbars
and menu bars are functionally identical. However, I'll continue to discuss menu
bars as if they are something different.

Using a Mouse

Opening the menu with a mouse is quite straightforward. Click the menu that vou
want to open and it drops down to display menu items, also called commands, as
shown in Figure 4-6. Click the menu item to issue the command.

Figure 4-6: Opening Excel’s
Edit menu displays
its menu items.
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Some menu items lead to an additional submenu; when you click the menu item, the
subrmenu appears to its right. Menu items that have a submenu display a small
triangle. For example, the Edit» Clear command has a submenu, shown in Figure
4-7. Excel's designers incorporated submenus primarily to keep the menus from
becoming too lengthy and overwhelming to users.
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Some menu items also have shorteut keys associated with them. The ones that do
usually display the key combination next to the menu item. For example, the Edit
Find command’s shortcut key combination is Ctrl+F

e s

Figure 4-7: The submenu of the Edit« Clear
command.

Sometimes, you’'ll notice that a menu item appears grayved out. This simply means
that the menu item isn’t appropriate for what you’re doing. Nothing happens if you
select such a menu item.

Menu items that are followed by an ellipsis (three dots) always display a dialog
box. Menu commands that don't have an ellipsis are executed immediately. For
example, the Insert» Cells command results in a dialog box, because Excel needs
more information about the command. The Insert* Rows command doesn’t need
a dialog box, so Excel performs this command immediately.
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To issue a menu command from the keyboard, press Alt and then the menu’s hot
key. The hot key is the underlined letter in the menu; for example E is the hot key of
the Edit menu. After you open the menu, you can press the appropriate hot key for
a command on the menu. For example, to issue the Data* Sort command, press Alt,
press D, and then press S.

You also can press Alt alone, or F10. This selects the first menu (the File menu).
Next, vou use the direction keys to highlight the menu that you want, and then
press Enter. In the menu, use the direction keys to choose the appropriate menu
item, and press Enter again.

Moving the Menu

In Excel 2000, a menu bar is the same as a taolbar. Because the menu bar is a toolbar,
you can move the menu to a new location, if you prefer. To move the menu, just click
and drag it to its new location. This can be a bit tricky, because you must click the
menu in a location that doesn’t contain a menu item, such as to the right of the Help
menu. You can drag the menu to any of the window borders or leave it free-floating.
Figure 49 shows the menu after relocating it to the left side of the window.

i f L i
Figure 4-9: You can move Excel’'s menu to a new loca

i

tion.
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Learn how to customize Excel's menus (and toolbars) in Chapter 33.

Using Shortcut Menus

Besides the omnipresent menu bar, discussed in the preceding section, Excel features
a slew of shortcut menus. A shorteut menu is context-sensitive — its contents depend
on what you're doing at the time. Shortcut menus don’t contain all the relevant coni-
mands, just those that are most commonly used for whatever is selected. You can dis-
play a shortcut menu by right-clicking just about anything in Excel.

As an example, examine Figure 4-10, which shows the shortcut menu (also called a
context menu) that appears when you right-click a cell. The shortcut menu appears
at the mouse-pointer position, which makes selecting a command fast and efficient.

Figure 4-10: Right-clicking a cell displays this shortcut menu.

The shortcut menu that appears depends on what is currently selected. For example,
if you're working with a chart, the shortcut menu that appears when vou right-click a
chart part contains commands that are pertinent to what is selected.
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Although shortcut menus were invented with mouse users in mind, you also can
display a shortcut menu by pressing Shift+F10.

Excel’s Toolbars

Excel, like all leading applications, includes convenient graphical toolbars. Clicking
a button on a toolbar is just anather way of issuing commands to Excel. In many
cases, a toolbar button is simply a substitute for a menu command. For example,
the Copy button is a substitute for Edit+ Copy. Some toolbar buttons, however,
don’t have any menu equivalent. One example is the AutoSum button, which auto-
matically inserts a formula to calculate the sum of a range of cells. Toolbars can be
customized to include menu commands as well as buttons.

By default, Excel displays two toolbars (named Standard and Formatting). Techni-
cally, it displays three toolbars, because the menu bar is actually a toolbar named
Worksheet mernu bar. All told, Excel 2000 has 23 built-in toolbars, plus the menu bar.
You have complete control over which toolbars are displaved and where they are
located. In addition, you can create custom toolbars, made up of buttons that you
find most useful.

Learn how to customize toolbars and create new toolbars in Chapter 33.
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Table 4-3 lists all of Excel’s built-in toolbars.

Toolbar Use

Chart Manipulate charts

Clipboard Tools to copy and paste multiple Clipboard selections between
Office applications

Stop Recording Record macros

Auditing Identify errors in your worksheet

Web Access the Internet from Excel

Exit Design Mode Toggle in and out of design mode (one tool only)

Chart Menu Bar The menu that appears when a chart is selected

Shadow Settings Insert or edit shadows that appear behind objects

o

s
:

The Clipboard toolbar {and the way the Clipboard functions in Office 2000 appli-
cations) is new in Excel 2000.

EXCEL
200
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See Chapter 8 for more information on the Clipboard.

Sometimes, Excel automatically pops up a toolbar to help you with a particular
task. For example, if you're working with a chart, Excel displays its Chart toolbar.

Hiding or Showing Toolbars

To hide or display a particular toolbar, choose View+ Toolbars, or right-click any
toolbar. Either of these actions displays a list of conunon toolbars (but not all
toolbars). The toolbars that have a check mark next to them are currently visible.
To hide a toolbar, click it to remove the check mark. To display a toolbar, click it to
add a check mark.

If the toolbar that you want to hide or show does not appear on the menu list,
select Views Toolbars+ Customize (or select Customize from the shortcut menu
that appears when vou right-click a toolbar). Excel displays its Customize dialog
box, shown in Figure 4-12. The Toolbars tab of this dialog box shows a list of all
toolbars that are available —the built-in toolbars, plus any custom toolbars.

The toolbars that have a check mark next to them are currently visible. To hide

a toolbar, click it to remaove the check mark. To display a toolbar, click it to add

a check mark. When you're finished, click the Close button.

Figure 4-12: Choose which toolbars to
display in the Customize dialog box.

The Customize dialog box has some other options with which you may want to
experiment. Click the Options tab to display these options (see Figure 4-13). The
check boxes at the top of the Options tab were discussed earlier in the chapter.
The button labeled Reset my usage data, in the middle of Figure 4-13, works in
conjunction with the check box titled Menus show recently used commands first.
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Excel determines the commands to show hased on the commands that yvou use
most often. Clicking the Reset my usage data tells Excel to ignore your past usage
and reset the menu commands to the defaults that shipped with the product. If
you leave the check in the Menus show recently used commands first check box
after resetting usage, Excel starts the “monitoring” process over again to deter-
mine which commands you're using most often.

Figure 4-13: The Options tab of the Customize
dialog box provides some options for toolbars.

% Chapter 33 discusses the Commands tab of the Customize dialog box.

If vou prefer larger buttons, check the Large icons check box. By default, when vou
open the Font list box, font names provide a sample of the font (see Figure 4-14). This
is useful, but it also slows things down quite a bit. For a faster font list, remove the
check from the check box titled List font names in their font. And if you find those
pop-up screen tips distracting, uncheck the Show ScreenTips on toolbars check box.
You can also specify what type of animation you prefer for the menus.

Moving Toolbars

Toolbars can be moved to any of the four sides of Excel’s window, or can be free-
tfloating. A free-floating toolbar can be dragged onscreen anywhere that you want.
You also can change a toolbar’s size simply by dragging any of its borders. To hide
a freefloating toolbar, click its Close button.

Because Excel 2000 menu bars are actually toolbars, this discussion also applies to
the menu bars.
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Figure 4-14: By default, font names provide a sample of the font.

When a toolbar isn’t free-floating, it’s said to be docked. A docked toolbar is stuck to
the edge of Excel’'s window and doesn’t have a title bar. Therefore, a docked toolbar
can’t be resized.

To move a toolbar (docked or free-floating), click and drag anywhere on the back-
ground of the toolbar (that is, anywhere except on a button). When yvou drag it
toward the window’s edge, it automatically docks itself there. When a toolbar is
docked, its shape changes to a single row or single column.

Learning More About Toolbars

Describing all the toolbar buttons available would take many pages, so [ won't
even try. You are charged with discovering this handy feature on your own. But,
throughout the rest of the book, I point out toolbar buttons that may be useful in
particular situations.

Chapter 33 discusses toolbars in more detail, including how to customize toolbars.
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Shortcut Keys

This chapter mentioned earlier that some menu commands have equivalent shortcut
keys. Usually, the shortcut key combination is displayed next to the menu item—
providing a built-in way for you to learn the shortcuts as you select the commands.

Throughout the book, shortcut keys are examined that are relevant to any particu-
lar topic.

Appendix C lists all the shortcut keys available in Excel.

Working with Dialog Boxes

As previously stated, menu items that end with an ellipsis (three dots) result in a
dialog box. All Windows programs use dialog boxes, so vou may already be familiar
with the concept.

About Dialog Boxes

You can think of a dialog box as Excel's way of getting more information from you
about the command that you selected. For example, if you choose Viewes Zoom
(which changes the magnification of the worksheet), Excel can’t carry out the com-
mand until it finds out from you what magnification level you want. Dialog boxes
can be simple or much more complicated. Dialog boxes are made up of several
items, known as controls.

When a dialog box appears in response to your command, you make additional
choices in the dialog box by manipulating the controls. When vou're finished,
click the OK button (or press Enter) to continue. If you change your mind, click
the Cancel button (or press Escape) and nothing further happens —it’s as if the
dialog box never appeared.

If a dialog box obscures an area of your worksheet that you need to see, simply
click the dialog box’s title bar and drag the box to another location. The title bar
in a dialog box has two controls: a Help button (Question-mark icon) and a Close
button. When you click the Help button, the mouse pointer displays a question
mark. You can click any part of the dialog box to get a description of that part’s
purpose. Clicking the Close button is the same as clicking the Cancel button or
pressing Escape.

Although a dialog box locks like just another window, it works a little differently.
When a dialog box appears, yvou can’t do anything in the workbook until the dialog
box is closed. In other words, vou must dismiss the dialog box before you can do
anything.

CiM Ex. 1051 Page 103



Dialog Box Controls

Most people find working with dialog boxes to be quite straightforward and natural.
The controls usually work just as you would expect, and they can be manipulated
either with your mouse or directly from the keyhoard.

The following sections describe the most common dialog box controls and show
solne examples.

Buttons

A button control is about as simple as it gets. Just click it and it does its thing. Most
dialog boxes have at least two buttons. The OK button closes the dialog box and
executes the command. The Cancel button closes the dialog box without making any
changes. If an ellipsis appears after the text on a button, clicking the button leads to
another dialog box.

Pressing the Alt key and the button’s underlined letter is equivalent to clicking the
button. Pressing Enter is the same as clicking the OK button, and pressing Esc is
the same as clicking the Cancel button.

Option buttons

Option buttons are sometimes known as radio buttons, because they work like the
preset station buttons on an ald-fashioned car radio. Like these car radios, only
one option button at a time can be “pressed.” Choosing an option button is like
choosing a single item on a computerized multiple-choice test. When you click an
option button, the previously selected option button is unselected.

Option buttons usually are enclosed in a group box, and a single dialog box can

have several sets of option buttons. Figure 415 shows an example of a dialog box
with option buttons.
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Figure 4-15: This dialog
box has seven option
buttons.

Check boxes

A check box control is used to indicate whether an option is on or off. This is similar
to responding to an item on a True/False test. Figure 4-16 shows a dialog box with
several check boxes. Unlike option buttons, each check box is independent of the
others. Clicking a check box toggles on and off the check mark.

Figure 4-16: An example of check boxes in
a dialog box.

Range selection boxes

A range selection box enables you to specify a worksheet range by dragging inside
the worksheet. A range selection box has a small button that, when clicked, col-
lapses the dialog box, to make it easier for you to select the range by dragging in
the worksheet. After vou select the range, click the button again to restore the
dialog box. Figure 4-17 shows a dialog box with two range selection box controls.
The control in the middle is a standard edit box.

Spinners

A spinner control makes specifying a number easy. You can click the arrows to
increment or decrement the displayed value. A spinner is almost always paired
with an edit box. You can either enter the value directly into the edit box or use
the spinner to change it to the desired value. Figure 4-18 shows a dialog box with
several spinner controls.
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Figure 4-17: A range selection
box enables you to specify a
worksheet range by dragging
in the worksheet.

Figure 4-18: This dialog box has several spinner controls.

List boxes

A list box control contains a list of options from which you can choose. If the list is
longer than will fit in the list box, vou can use its vertical scrollbar to scroll through
the list. Figure 4-19 shows an example of a dialog box that contains two list box
controls.

Figure 4-19: Two list box controls in a dialog box.
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Drop-down boxes

Drop-down boxes are similar to list boxes, but they show only a single option at a
time. When vou click the arrow on a drop-down box, the list drops down to display
additional choices. Figure 4-20 shows an open drop-down box control.

%

Figure 4-20: A drop-down box control in a dialog box.

Tabbed Dialog Boxes

Many of Excel’s dialog boxes are “tabbed” dialog boxes. A tabbed dialog box includes
notebook-like tabs, each of which is associated with a different panel. When vou click
a tab, the dialog box changes to display a new panel containing a new set of controls.
The Format Cells dialog box, which appears in response to the Format+ Cells com-
mand, is a good example. This dialog box is shown in Figure 4-21. Notice that it has
six tabs, which makes it functionally equivalent to six different dialog boxes.

Tabbed dialog boxes are quite convenient, because you can make several changes
in a single dialog box. After you make all of your setting changes, click OK or
press Enter.

Figure 4-21: The Format Cells dialog box is
an example of a tabbed dialog box.
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To select a tab by using the keyboard, use Ctrl+PgUp or Ctrl+PgDn, or simply press
the first letter of the tab that you want to activate.

Summary

This chapter covers background information that is essential to using Excel effi-
ciently. It discusses methods to manipulate windows (which hold workbooks), as
well as several techniques used to move around within a worksheet by using the
mouse or the kevhoard. It also discusses the various methods used to issue com-
mands to Excel: menus, shortcut menus, toolbar buttons, and shortcut key combi-
nations. This chapter concludes with a general discussion of dialog boxes—an ele-
ment common to all Windows programs.

 SONEERISIER  SEOSNIISER
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Working with
Files and
Workbooks

‘ omputer users won't get too far without understanding

the concept of files. Every computer program uses files,
and a good understanding of how to manage files stored on
your hard drive will make your job easier. This chapter dis-
cusses how Excel uses files and what vou need to know about
files to use Excel.

Some Background on Files

A file is an entity that stores information a disk. A hard disk is
usually organized into directories (or folders) to facilitate the
organization of files. For example, all the files that comprise
Excel are stored in a separate folder on your computer. And,
your system probably has a directory named Personal (located
in vour Windows directory) that is used as the default location
for storing Excel workbooks.

Files can be manipulated in several ways. They can be copied,
renamed, deleted, or moved to another disk or folder. These
types of file operations are usually performed by using the tools
in Windows (although you also can perform these operations
without leaving Excel).

Computer programs are stored in files, and programs also store
information that they use in files. Some programs (such as
Excel) use files by loading them into memory. Others (such as
database programs) access selective parts of a file directly from
the disk and don’t read the entire file into memory.

Windows makes it easy to access properties of files. Properties
include information such as file type, size, date created, its
read-only status, and so on. Excel enables you access some
additional custom properties of files that can help vou to
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locate and categorize your files. For example, you can store information that
enables you quickly to locate all workbook files that apply to a particular client.

How Excel Uses Files

When you installed Excel (or the entire Microsoft Office suite) on your system, the
Setup program copied many files to vour hard disk and created several new folders
to hold the files. These files consist of the files that are needed to run Excel, plus
some sample files and Help files. The Setup program also made (or modified) some
entries in the Windows Registry. The Registry is a master database of sorts that
keeps track of all configuration information for the operating system and the soft-
ware installed on vour system, and also associates Excel’s data files with Excel.

Excel’s Data Files

Excel’'s primary file type is called a workbook file. When vou open a workbaook in
Excel, the entire file is loaded into memory, and any changes that you make occur
only in the copy of the file that’s in memory. If the workbook is large, your system
may not have enough memory to hold the file. In such a case, Windows uses disk-
based virtual memory to simmilate actual memory (this slows things down consider-
ably). When you save the workbook, Excel saves the copy in memory to your disk,
overwriting the previous copy of the file.

Table 5-1 lists the various types of files that Excel supports directly.

File Type Description

XLA Excel add-in file (several add-ins are supplied with Excel, and you can create
your own add-ins)

XLC Excel 4 chart file*

XLM Excel 4 macro file*

XLT 7 Excel template file

These files became obsolete beginning with Excel 5. However, Excel can still read these files for compatibility
with previous varsions.
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Foreign File Formats Supported

Although Excel’s default file format is an XLS workbook file, it also can open files
generated by several other applications. In addition, Excel can save workbooks in
several different formats. Table 5-2 contains a list of file formats that Excel can read
and write.

Chapter 22 covers file importing and exporting in detail.

File Type Description

WK1

WK4 1-2-3 for Windows spreadsheet format

WB1 Quattro Pro for Windows spreadsheet format**

SLK SYLK spreadsheet format

Hypertext Markup Language files

TXT :i'ext file format

DIF Data interchange format

** Excel can open files in this format, but not save them.

**# yvhan you open one of these files, Excel searches for the associated formatting file (either FMT or FM3) and
attempts to translate the formatting.

Excel 2000 lets you use HTML as a “native” file format. HTML is the file format
used by Web browsers. You can save and retrieve files using this format, with no
loss of information.

This new HTML feature is discussed in Chapter 30.
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Essential Workbook File Operations

This section describes the operations that you perform with workbook files: open-
ing, saving, closing, deleting, and so on. As vou read through this section, keep in
mind that vou can have any number of workbooks open simultaneously, and that at
any given time, only one workbook is the active workbook. The workbook’s name is
displayed in its title bar (or in Excel’s title bar if the workbook is maximized).

Creating a New Workbook

When you start Excel, it automatically creates a new (empty) workbook called Bookl.
This workbook exists only in memory and has not been saved to disk. By default, this
workbook consists of three worksheets named Sheetl, Sheet2, and Sheet3. If you're
starting a new project from scratch, you can use this blank workbook.

You can always create another new workbaook in either of three ways:

» Use the File« New command

* (lick the New Workbook button on the Standard toolbar (this button has an
image of a sheet of paper)

* Press the Ctrl+N shortcut key combination

If you choose the Files New command, you're greeted with a dialog box named
New (see Figure 5-1). This is a tabbed dialog box that enables you to choose a
template for the new workbook. If you don’t have any custom templates defined,
the General tab displays only one option: Workbook. Clicking this gives you a plain
workbook. Templates that are included with Excel are listed in the Spreadsheet
Solutions tab. If you choose one of these templates, your new workbook is based
on the selected template file.

Templates are discussed later in this chapter, and Chapter 33 discusses this topic
in detail.

Pressing Ctrl+N or clicking the New button on the Standard toolbar bypasses the
New dialog box and creates a new default workbook immediately. If you want to
create a new workbook based on a template, you must use the File» New command.

if you find that you almost always end up closing the default Book1 workbook that
appears when you start Excel, you can set things up so that Excel starts without an
empty workbook. To do so, you need to edit the command line that you use to
start Excel. For example, if you start Excel by using a shortcut on your Windows
desktop, right-click the shortcut icon and choose Properties from the menu. Click
the Shortcut tab and add /e after the command line listed in the Target field. The
following is an example of a command line modified in this manner (the actual
drive and path may vary on your system):

C:\Program Files\Microsofl Office\Officelexcel.exe /e
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Figure 5-1: The New dialog box enables you to choose a template
upon which to base the new workbook.

Opening an Existing Workbook

The following are the ways to open a workbook that has been saved on your disk:

» Use the File» Open command

« (lick the Open button on the Standard toolbar (the Open button has an image
of a file folder opening)

» Press the Ctrl+O shortcut key combination
All of these methods result in the Open dialog box, shown in Figure 5-2.

You also can open an Excel workbook by double-clicking its icon in any folder
window. If Excel isn’t running, it starts automatically. Or, you can drag a workbook
icon into the Excel window to load the workbook.

If you want to open a file that you've used recently, it may be listed at the bottom
of the drop-down File menu. This menu shows a list of files that you’ve worked on
recently. Just click the filename and the workbook opens for yvou (bypassing the
Open dialog box).

You select the number of files to display in the recent file list—from zero up to
nine. To change this setting, use Tool+ Options. In the Options dialog box, click
the General tab and make the change to the Recently used file list setting.

The Open dialog box has a new look in Excel 2000. It provides icons along the left
side so that you can quickly activate certain folders. For example, clicking the
Desktop icon activates your Windows\Desktop directory—which contains the file
and shortcuts displayed on your desktop.
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Figure 5-2: The Open dialog box.

To open a workbook from the Open dialog box, yvou must provide two pieces of
information: the name of the workbook file (specified in the File name field) and its
folder (specified in the Look in field).

This dialog box may be a bit overwhelming at first. You can ignore most of it,
because many of the controls deal with locating files. If yvou know what folder the
file is in, you simply specify the folder and then select the filename (and don’t
forget about the new icons on the left side of the Open dialog box). Click Open
and the file opens. You also can just double-click the filename to open it.

In Excel 2000, the Open button is actually a drop-down list. Click the arrow and you
see the additional options:
« Open: Opens the file normally.

* Open Read Only: Opens the selected file in read-only mode. When a file is
opened in this mode, changes cannot be saved to the original filename.

* Open as Copy: Opens a copy of the selected file. If the file is named budget.xls,
the workbook that opens is named copy of budget xls.

» Open in Browser: Opens the file in your default Web browser.

You can hold down the Ctrl key and select multiple workbooks. When you click
OK, all the selected workbook files will open.

Right-clicking a filename in the Open dialog box displays a shortcut menu with many
extra choices. For example, yvou can copy the file, delete it, modify its properties,
and so on.
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Specifying a folder

The Look in field is actually a drop-down box. Click the arrow and the box expands
to show your system components. You can select a different drive or directory from
this list. The Up One Level icon (a file folder with an upward arrow) moves up one
level in the folder hierarchy.

As noted previously, you can also click any of the following icons to activate a partic-
ular directory:

Ieon Folder

History c:\windows\recent
Personal cxwindows\personal
Desktop c\windows\desktop
Favorites chwindows\favorites
Web Folders c\windows\web folders

Filtering by file type

At the bottom of the Open dialog box, the drop-down list is labeled Files of type.
When this dialog box is displayed, it shows All Microsoft Excel Files (* x1*, * xls,

* xla, * xlt, * xlw). This means that the files displayed are filtered, and you see only
files that have an extension beginning with the letters XL. In other words, you see
only standard Excel files: workbooks, add-ins, templates, and workspace files.

If vou want to open a file of a different type, click the arrow in the drop-down list and
select the file type that you want to open. This changes the filtering and displays only
files of the type that you specify.

File display preferences
The Open dialog box can display yvour workbook filenames in four different styles:

» List: As a list of filenames only, displayed in multiple columns

» Details: As a list of filenames, with details about each file (its size, file type,
and when it was last modified)

« Properties: As a list of filenames, with file properties displayed in a separate
panel for the selected file

» Preview: As a list of filenames, with a preview screen displayed in a separate
panel for the selected lile

You control the style by clicking the View icon and then selecting from the drop-
down list. The View icon is located in the upper-right section of the Open dialog
box (see Figure 5-3). The style that you choose is entirely up to you.
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Opening Workbooks Automatically

Many people find that they work on the same workbooks day after day. If this
describes you, you’ll be happy to know that you can have Excel open specific
workbook files automatically whenever you start Excel.

The XLStart folder is located within the Microsoft Office folder. Any workbook files
(excluding template files) that are stored in this folder open automatically when
Excel starts. If one or more files open automatically from this folder, Excel won't
start up with a blank workbook.

You can specify an alternate startup folder in addition to the XLStart folder. Choose
Tools+ Options and select the General tab. Enter a new folder name in the field
labeled Alternate Startup File Location. After you do that, when you start Excel, it
automatically opens all workbook files in both the XLStart folder and the alternate
folder that you specified.

Saving Workbooks

When you're working on a workbook, it’s vulnerable to day-ruining events, such as
power failures and system crashes. Therefore, you should save your work to disk
often. Saving a file takes only a few seconds, but re-creating four hours of lost work
takes about four hours.

Excel provides four ways to save your workbook:

» Use the File+ Save command

+ (lick the Save button on the Standard toolbar

Press the Ctrl+S shortcut key combination

* Press the Shift+F12 shortcut key combination

If your workbook has already been saved, it’s saved again using the same filename.
If you want to save the workhook to a new file, use the File* Save As command (or
press F12).

If your workbook has never been saved, its title bar displays a name such as Bookl
or BookZ2. Although Excel enables you to use these generic workbook names for file-
names, it’s not recommended. Therefore, the first time that you save a new worbook,
Excel displays the Save As dialog box (see Figure 54) to let you provide a more mean-
ingful name.

CiM Ex. 1051 Page 119



The Save As dialog box is somewhat similar to the Open dialog box. Again, you
need to specify two pieces of information: the warkbook’s name and the folder in
which to store it. If vou want to save the file to a different folder, select the desired
folder in the Save in field. If you want to create a new folder, click the Create New
Folder icon in the Save As dialog box. The new folder is created within the folder
that’s displayed in the Save in field.

After vou select the folder, enter the filename in the File name field. You don’t need to
specify a file extension —Excel adds it automatically, based on the file type specified
in the Save as type field.

If a file with the same name already exists in the folder that you specify, Excel asks

whether you want to overwrite that file with the new file. Be careful with this,
because you can't recover the previous file if you overwrite it.
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Figure 5-4: The Save As dialog box.

Remember, saving a file overwrites the previous version of the file on disk. If you
open a workbook and then completely mess it up, don't save the file! Instead,
close the workbook without saving it, and then open the good copy on disk.
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The default file location

When you save a workbook file for the first time, the Save As dialog box proposes a
folder in which to save it. Normally, this is the Personal folder (located within your
\Windows folder). If you want, you can change the default {ile location. To do so,
choose Tools+ Options and click the General tab in the Options dialeg box. Then,
enter the folder’s path into the field labeled Default File Location. After doing so,
the Save As dialog box defaults to this folder.

Note, however, that if you override the default folder in the Save As dialog box, the
new folder becomes the default folder for the current Excel session. So, if you use
the File+ Save As command to save another workbook, Excel proposes the new
default folder.
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File saving options

The Save As dialog box has a drop-down menu labeled Tools. When you click this

menu, one of the options displayed is labeled General Options. Selecting this item
displays the Save Options dialog box, shown in Figure 5-5. This dialog box enables
you to set the following options:

« Always create backup: If this option is set, the existing version of the workbook
is renamed as a BAK file before the workbook is saved. Doing this enables you
to go back to the previously saved version of your workbook. Some users like to
use this option because it adds another level of safety. Just be aware that your
worksheet files will take up about twice as much disk space, s0 it’s a good idea
to delete the backup files occasionally.

« Password to open: If you enter a password, the password is required before
anyone can open the workbook. You're asked to enter the password a second
time to confirm it. Passwords can be up to 15 characters long and are case-
sensitive. Be careful with this option, because it is impossible to open the
workbook (using normal methods) if you forget the password.

Figure 5-5: The Save Options
dialog box.

» Password to modify: This option enables you to specify a password that will
be required before changes to the workbook can be saved under the same
filename. Use this option if you want to make sure that changes aren’t made
to the original version of the workbook. In other words, the workbook can be
saved with a new name, but a password is required to overwrite the original
version.

* Read-only recommended: If this option is checked, the file can’t be saved
under its original name. This is another way to ensure that a workbook file
isn’t overwritten.

File security is not one of Excel's strong points. Saving a workbook with a pass-
word is not a foolproof method of protecting your work. Several utilities exist that
are designed to “crack” passwords in Excel files. Therefare, if you need to keep
your work absolutely confidential, Excel is not your best software choice.
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Using AutoSave can be helpful, but it can also be risky. When an Excel workbook is
saved, the Undo stack is reset. Therefore, if you make a mistake (such as deleting
a range of data) and AutoSave kicks in and saves your file, you won't be able to
use Undo to reverse your mistake.

Workbook summary information

When you save a file for the first time by closing the Save As dialog box, Excel may
prompt vou for summary information by displaying the Properties dialog box, shown
in Figure 5-6. This dialog box enables you to specify lots of descriptive information
about the workbook, and also displays some details about the file.

The Properties dialog box may or may not appear, depending on how Excel is con-
figured. To specify whether to display the Properties dialog box automatically,
select Tools+ Options, click the General tab, and adjust the setting of the Prompt
for File Properties check box.
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Figure 5-6: You can provide all sorts of
information about your workbook in the
Properties dialog box.

The Properties dialog box has the following five tabs:

» General: Displays general information about the file —its name, size, location,
date created, and so on. You can’t change any of the information in this panel.

* Summary: Appears by default when vou first save the file. [t contains nine
fields of information that you can enter and modify. You can use the informa-
tion in this panel to locate workbooks quickly that meet certain criteria. This
is discussed later in the chapter.

» Statistics: Shows additional information about the file, and can’t be changed.

» Contents: Displays the names of the sheets in the workbook, arranged by
sheet type.

+ Custom: Can be quite useful if you use it consistently. Basically, it enables you
to store in a sort of database a variety of information about the file. For exam-
ple, if the workbook deals with a client named Smith and Jones Corp., you can
keep track of this bit of information and use it to help locate the file later.

You also can access the Properties dialog box for the active workbook at any time
by selecting File« Properties from the menu. In addition, you can view the proper-
ties of a workbook from the Open dialog box. Right-click the file in which you're
interested and choose Properties from the shortcut menu.
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Saving files in older formats

If your colleagues also use Excel, you may find yourself exchanging workbook files.
If so, it’s important that you know which version of Excel they use. Excel 97 and
Excel 2000 use the same file format, but previous versions of Excel use different file
formats. Generally, newer versions of Excel can open files created in older versions,
but older versions of Excel cannot open files created in newer versions.

If you send a workbook to someone who uses a version of Excel prior to Excel 97,
yvou must remember to save the file in a format that the earlier version can read.

Even though Excel 97 and Excel 2000 use a common file format, this does not
ensure complete compatibility. If your workbook makes use of any features new to
Excel 2000, these features won't be available if the file is opened in Excel 97.

Excel b was the first version to use multisheet workbooks. Prior to Excel 5, wark-
sheets, chart sheets, and macro sheets were stored in separate files. Consequently,
if you share a multisheet workbook with someone who still uses one of these older
versions, you must save each sheet separately —and in the proper format.

The Save As dialog box has a field labeled Save as type that enables you to choose
the format in which to save the file. The Excel file formats are listed in Table 5-3.

Excel 2000 has an option that enables you to specify the default format for saved
workbooks. To change the default setting, select Tools« Options, click the
Transition tab, and then choose the file type from the drop-down list labeled Save
Excel files as.

This is improved over the Excel 97 version of the same feature, which prompts
users on every file save if this option is enabled.

Format What It Does

Microsoft Excel 97-9 Saves the file in a format that can be read by
& 5.0/95 Workbook Excel 5 through Excel 2000

Microsoft Excel 4.0 Worksheet* Saves the file in a format that can be read by Excel 4

Microsoft Excel 2.1 Worksheet* Saves the file in a format that can be read by Excel 2.1

* These file formats do not support multisheet workbooks.
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If vou need to send a workbook with three worksheets in it to a colleague who uses
Excel 4, you must save it as three separate files and make sure that vou select the
Microsoft Excel 4.0 Worksheet option from the Save as type drop-down box (see
Figure 5-7).

51 Change Event.xls
Combinations. xis

11 dataforma.xls
1] Delete Unused Names.ds

onthly saies. xls

icrosoft: Excel Workbook (* xls)

icrosoft Excel Waorkbock (*.x1s)
‘web Page (*.htm; * homi)

by previous versions of Excel.

Closing Workbooks
When you’re finished with a workbook, vou should close it to free the memory that
it uses. You can close a workbook by using any of the following methods:

» Use the File+ Close command

» Click the Close button in the workbook’s title bar

» Double-click the Control icon in the workbook’s title bar

* Press the Ctrl+F4 shortcut key

» Press the Ctrl+W shortcut key

If yvou've made any changes to your workbook since it was last saved, Excel asks
whether vou want to save the workbook before closing it.
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To close all open workbooks, press the Shift key and choose File« Close All. This
command appears only when you hold down the Shift key while you click the File
menu. Excel closes each workbook, prompting you for each unsaved workbook.

Using Workspace Files

As you know, you can work with any number of waorkbook files at a time. For exam-
ple, you may have a project that uses two workbooks, and you like to arrange the
windows in a certain way to make it easy to access them both. Fortunately, Excel
enables yvou to save your entire workspace to a file. Workspace, as used here, means
all the workbooks and their screen pasitions and window sizes —sort of a snapshot
of Excel’s current state. Then, you can open the workspace file, and Excel is set up
exactly as it was when you saved your workspace.

To save your workspace, use the Files Save Workspace command. Excel proposes
the name resume.xlw for the workspace file. You can use this name or enter a differ-
ent name in the File name field. Click the Save button, and the workspace will be
saved to disk.

You need to understand that a workspace file doesn’t include the workbook files
themselves. It includes only the information needed to recreate the workspace.
The workbooks in the workspace are saved in standard workbook files. Therefore,
if you distribute a workspace file to a coworker, make sure that you also include
the workbook files to which the workspace file refers.

if you save your workspace file in the XLStart folder, Excel opens the warkspace file
automatically when it starts up. This is handy if you tend to work with the same
files every day, because essentially you can pick up where you left off the previous

day.

Sharing Workbooks with Others

If your system is connected to a network, you should be aware of some other issues
related to workbook files,

Chapter 21 is devoted entirety to workgroup issues.

Using Template Files

You may be able to save yourself a lot of work by using a template instead of creat-
ing a new workbook from scratch. A template basically is a worksheet that’s all set
up with formulas, ready for vou to enter data.

The templates distributed with Excel are nicely formatted and relatively easy to
customize. When you open a new workbook based on the template, you save the
workbook to a new file. In other words, you don’t overwrite the template.
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Figure 5-8: Excel includes several templates, designed to perform cormmon tasks.
This figure shows the Invoicel template.

Excel 2000 includes three templates:

« Expense Statement: Helps you create expense report forms and a log to track
them

« Invoice: Helps you create invoices

« Purchase Order: Helps you create purchase orders to send to vendors

Another template, named Village, is also available, This isn’t really a template. It
describes how to purchase additional templates from Village Software.

You can download additional templates from Microsoft's Web site:

”3 http://officeupdate .microsoft,com/

The Spreadsheet Solutions templates are handy, but be aware that they include

a lot of overhead — several worksheets, dialog sheets, and a custom toolbar.
Consequently, the workbooks that you generate by using these templates may be
larger than you would expect. On the positive side, studying how these templates
are designed can provide advanced users with some great tips.
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Chapter 33 discusses templates in more detail and describes how to create your
own template files.

Protecting Your Work

The final topic in this chapter offers a few words on backing up your work to protect
yourself from disaster —or at least save yourself the inconvenience of repeating your
work. Earlier in the chapter, vou learned how to make Excel create a backup copy of
your workbook when you save the file. That's a good idea, but it certainly isn’t the
only backup protection you should use.

If you've been around computers for a while, yvou probably know that hard disks
aren’t perfect. ['ve seen many hard disks fail for no apparent reason and with
absolutely no advance warning. In addition, files can get corrupted — which usu-
ally makes them unreadable and essentially worthless. If a file is truly important,
you need to take extra steps to ensure its safety. The following are several backup
options for ensuring the safety of individual files:

» Keep a backup copy of the file on the same drive. This is essentially what
happens when you select the Always create a backup option when you save
a workbook file. Although this offers some protection if you create a mess
of the worksheet, it won’t do you any good if the entire hard drive crashes.

» Keep a backup copy on a different hard drive. This assutnes, of course, that
your system has more than one hard drive. This offers more protection than
the preceding method, because the likelihood that both hard drives will fail is
remote. [f the entire system is destroyved or stolen, however, you're out of luck.

» Keep a backup copy on a network server. This assumes that your system is
connected to a server on which you can write files. This method is fairly safe.
If the network server is located in the same building, however, you're at risk if
the entire building burns down or is otherwise destroyed.

» Keep a backup copy on a removable medium. This is the safest method.
Using a removable medium, such as a floppy disk or tape, enables you physi-
cally to take the backup to another location. So, if yvour system (or the entire
building) is damaged, your backup copy remins intact.

Most people with good backup habits acquired them because they’'ve been burned
in the past (myself included).

Windows comes with software that you can use to back up your entire system.
Consult your Windows manual or online help for details.
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Summary

This chapter covers the rather broad topic of files. It starts with an overview of
how computers use files and narrows the scope to cover how Excel uses files. The
chapter includes a discussion of the essential file operations that you perform from
Excel, including creating new workbook files, opening existing files, saving files, and
closing files. The chapter concludes with an introduction to the template files that
are included with Excel.

* ORI E KNG ER MRS
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Entering and
Editing
Worksheet Data

People use spreadsheets primarily to store data and per-
form calculations. This chapter discusses the various
types of data that you can enter into Excel.

Types of Worksheet Data

As you know, an Excel workbook can hold any number of
worksheets, and each worksheet is made up of cells. A cell
can hold any of three types of data:

» Values

+ Text

+ Farmulas
A worksheet also can hold charts, maps, drawings, pictures,
buttons, and other objects. These objects actually reside on

the worksheet’s draw layer, which is an invisible layer on top
of each worksheet.

The draw layer is discussed in Chapter 14. This chapter is
concerned only with data that you enter into worksheet cells.

Values

Values, also known as numbers, represent a quantity of some
type: sales, number of employees, atomic weights, test scores,
and so on. Values that you enter into cells can be used in
formulas or can be used to provide the data that is used to
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create a chart. Values also can be dates (such as 6/9/2019) or times (such as 3:24
a.m.), and you'll see that you can manipulate these types of values quite efficiently.

Figure 6-1 shows a worksheet with some values entered in it.

Text

Most worksheets also include non-numeric text in some of their cells. You can
insert text to serve as labels for values, headings for columns, or instructions about
the worksheet. Text that begins with a number is still considered text. For example,
if you enter an address such as 1425 Main St. into a cell, Excel considers this to be
text rather than a value.

Figure 6-2 shows a worksheet with text in some of the cells. In this case, the text is
used to clarify what the values mean.

i
Figure 6-2: This worksheet consists of text and values.
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Formulas

Formulas are what make a spreadsheet a spreadsheet — otherwise, you’d just have
a strange word processor that is good at working with tables. Excel enables you to
enter powerful formulas that use the values (or even text) in cells to calculate a
result. When you enter a formula into a cell, the formula’s result appears in the cell.
If you change any of the values used by a formula, the formula recalculates and
shows the new result. Figure 6-3 shows a worksheet with values, text, and formulas.

Chapter 9 discusses formulas in detail.

T B e T

Figure 6-3: Cells B8 and B9 contain formulas that use the other values.
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Entering Values

Entering values into a cell is quite easy. Just move the cell pointer to the appropriate
cell to make it the active cell, enter the value, and then press Enter. The value is dis-
plaved in the cell and also appears in Excel’s formula bar. You can, of course, include
decimal points and dollar signs when entering values and dollar signs, along with
plus signs, minus signs, and commas. If you precede a value with a minus sign or
enclose it in parentheses, Excel considers it to be a negative number.

Sometimes, the value that you enter won't be displayed exactly as you enter it
More specifically, if you enter a large number, it may be converted to scientific
notation. Notice, however, that the formula bar displays the value that you entered
originally. Excel simply reformatted the value so that it would fit into the cell. If you
make the column wider, the number is displayed as you entered it.

The section “Formatting values,” later in this chapter, discusses the various ways to
format values so that they appear differently.

Entering Text

Entering text into a cell is just as easy as entering a value: activate the cell, type the
text, and then press Enter. A cell can contain a maximum of about 32,000 characters.
To give you an idea of how much text can fit into a single cell, consider the fact that
this entire chapter has approximately 32,000 characters.

Even though a cell can hold a huge number of characters, you’ll find that it's not
possible to actually display all of them.

If you type an exceptionally long text entry into a cell, the characters appear to
wrap around when they reach the right edge of the window, and the formula bar
expands so that the text wraps around.

What happens when you enter text that’s longer than its column’s current width?
If the cells to the immediate right are blank, Excel displays the text in its entirety,
appearing to spill the entry into adjacent cells. If an adjacent cell is not blank, Excel
displays as much of the text as possible (the full text is contained in the cell; it’s
just not displayed). If you need to display a long text string in a cell that’s adjacent
to a nonblank cell, you can take one of several actions:

» Edit your text to make it shorter

* Increase the width of the column

» Use a smaller font

* Wrap the text within the cell so that it occupies more than one line

= Use Excel’s “shrink to fit” option (see Chapter 11 for details)
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Dates and Times

Often, vou need to enter dates and times into your worksheet. To Excel, a date or a
time is simply treated as a value —but it’s formatted to appear as a date or a time.

Working with Date Values

If you work with dates and times, you need to understand Excel’s date and time
system. Excel handles dates by using a serial number system. The earliest date that
Excel understands is January 1, 1900. This date has a serial number of 1. January 2,
1900, has a serial number of 2, and so on. This system makes it easy to deal with
dates in formulas. For example, vou can enter a formula to calculate the number of
days between two dates.

Most of the time, you don’t have to be concerned with Excel's serial number date
system. You can simply enter a date in a familiar date format, and Excel takes care
of the details behind the scenes. For example, if you need to enter June 1, 1999, vou
can simply enter the date by typing June 1, 1999 (or use any of several different
date formats). Excel interprets your entry and stores the value 36312 — which is the
date serial number for that date.

Here is a sampling of the date formats that Excel recognizes. After entering a date,
you can format it to appear in a different date format.

Entered into a Celil Excel’s Interpretation

6-1-1999 June 1, 1999

6/1/1999 June 1, 1999

June 1, 1999 June 1, 1999

June 1 June 1 of the current year

6-1 June 1 of the current year

After you enter a date, check the formula bar. If the formula bar displays exactly
what you entered, Excel didn't interpret the date that you entered as a date. If the
formula bar displays your entry in a format like mm /dd/yyyy, Excel correctly inter-
preted your entry as a date.
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As you can see, Excel is rather smart when it comes to recognizing dates that you
enter into a cell. It's not perfect, however. For example, Excel does not recognize
any of the following entries as dates: June 1 1999, Jun-1 1999, and Jun-1/1999.
Rather, it interprets these entries as text. If you plan to use dates in formulas, make
sure that the date you enter is actually recognized as a date; otherwise, your for-
mulas will produce incorrect results.

Working with Time Values

When you work with times, you simply extend Excel’s date serial number system
to include decimals. In other words, Excel works with times by using fractional
days. For example, the date serial number for June 1, 1999, is 36312. Noon Chalfway
through the day) is represented internally as 36312.5.

Again, you normally don’t have to be concerned with these serial numbers (or
fractional serial numbers, for times). Just enter the time into a cell in a recognized
format.

Here are some examples of time formats that Excel recognizes:

Entered into a Cell Excel’s Interpretation

11:30:00 AM 11:30 a.m.

11:30 11:30 am.

The preceding samples don’t have a day associated with them. You also can com-
bine dates and times, however, as follows:

Entered into a Ceil Excel’s Interpretation

6/1/99 11:30 11:30 a.m. on June 1, 1999
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Changing or Erasing Values and Text

Not surprisingly, you can change the contents of a cell after the fact. After you enter
a value or text into a cell, you can modify it in several ways:

» FErase the cell’s contents
* Replace the cell’s contents with something <lse

« Edit the cell’s contents

Erasing the Contents of a Cell

To erase the value, text, or formula in a cell, just click the cell and press Delete. To
erase more than one cell, select all the cells that you want to erase, and then press
Delete. Pressing Delete removes the cell’s contents, but doesn’t remove any format-
ting (such as bold, italic, or a different number format) that you may have applied
to the cell.

For more control over what gets deleted, you can use the Edit= Clear command.
This menu item has a submenu with four additional choices (see Figure 6-4), which
are described as follows:

All: Clears everything from the cell
« Formats: Clears only the formatting and leaves the value, text, ar formula
» Comntents: Clears only the cell’s contents and leaves the formatting

» Comments: Clears the comment (if one exists) attached to the cell

Replacing the Contents of a Cell

To replace the contents of a cell with something else, just click the cell and type
your new entry, which replaces the previous contents. Any formatting that you
applied to the cell remains.

Editing the Contents of a Cell

If the cell contains only a few characters, replacing its contents by typing new data
usually is easiest. But if the cell contains lengthy text or a complex formula, and
you need to make only a slight modification, you probably want to edit the cell
rather than reenter information.

When you want to edit the contents of a cell, you can use one of the following ways
to get into cell-edit mode:

* Double-click the cell. This enables you to edit the cell contents directly in
the cell.
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« Press F2, This enables you to edit the cell contents directly in the cell.

* Activate the cell that you want to edit and then click inside the formula bar.
This enables you to edit the cell contents in the formula bar.

clearing cells.

You can use whichever method you prefer. Some people find it easier to edit directly
in the cell; others prefer to use the formula bar to edit a cell. All of these methods
cause the formula bar to display two new icons, as shown in Figure 6-5. The X icon
cancels editing, without changing the cell’s contents (Esc has the same effect). The
Check Mark icon completes the editing and enters the modified contents into the
cell (Enter has the same effect).

if the cell contains a formula, you can edit the formula by using any of the tech-
niques listed previously. Or, you can take advantage of the Formula Palette. To acti-
vate the Formula Palette, click the = icon in the formula bar.
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While editing a cell, yvou can use the following key combinations to select characters
in the cell:

» Shift+left/right arrow: Selects characters to the left or right, respectively, of
the insertion point.

» Shift+Home: Selects all characters from the insertion point to the beginning

of the cell.

« Shift+End: Selects all characters from the insertion point to the end of the cell.

Formatting Values

Values that you enter into cells normally are unformatted. In other words, they
simply consist of a string of numerals. Typically, you want to format the numbers
so that they are easier to read or are more consistent in terms of the number of
decimal places shown.

You also can use the mouse to select characters while you’re editing a cell. Just
click and drag the mouse pointer over the characters that you want to select.

Figure 6-6 shows two columns of values. The first column consists of unformatted
values. The cells in the second column have been formatted to make the values
easier to read. [f you move the cell pointer to a cell that has a formatted value, you
find that the formula bar displays the value in its unformatted state. This is because
the formatting affects only how the value is displayed in the cell.
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Figure 6-6: Unformatted values (left column)

and the same values formatted.
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Automatic Number Formatting

Excel is smart enough to perform some formatting for you automatically. For exam-
ple, if you enter 12.2% into a cell, Excel knows that you want to use a percentage
format and applies it for you automatically. If yvou use commas to separate thousands
(such as 123,456), Excel applies comma formatting for you. And, if you precede your
value with a dollar sign, the cell will be formatted for currency.

A new feature in Excel 2000 makes it easier to enter values into cells formatted as
a percentage. Select Tools = Options, and click the Edit tab in the Options dialog
box. If the checkbox labeled Enable automatic percent entry is checked, you can
simply enter a normal value into a cell formatted as a percent (for example, 12.5
for 12.5%). If this checkbox is not checked, you must enter the value as a decimal
(for example, .125 for 12.5%).

Formatting Numbers Using the Toolbar

The Formatting toolbar, which is displayved, by default, to the right of the Standard
toolbar, contains several buttons that let you quickly apply common number for-
mats. When vou click one of these buttons, the active cell takes on the specified
number format. You also can select a range of cells (or even an entire row or col-
umn) before clicking these buttons. lf you select more than one cell, Excel applies
the number format to all the selected cells. Table 6-1 summarizes the formats that
these Formatting toolbar buttons perform. Remember to click the arrow at the right
end of the Formatting toolbar to see all of these buttons.

Increase Decimal Increases the number of digits to the right of the decimal point by one

These five toolbar buttons actually apply predefined “styles” to the selected cells.
These styles are similar to those used in word processing programs.
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Formatting Numbers by Using Shortcut Keys

Table 6-2 summarizes some shortcut key combinations that you can use to apply
common number formatting to the selected cells or range.

Key Combination  Formatting Applied

Ctrl+Shift+$ Currency format with two decimal places (negative numbers appear in
parentheses)

Ctrl+Shift+@ Time format with the hour, minute, and a.m. or p.

Other Number Formats

In some cases, the number formats that are accessible from the Formatting toolbar
(or by using the shortcut key combination) are just fine. More often, however, you
want more control over how your values appear. Excel offers a great deal of control
over number formats.

Figure 6-7 shows Excel’s Format Cells dialog box. This is a tabbed dialog box. For
formatting numbers, you need to use the tab labeled Number.

Several ways exist to bring up the Format Cells dialog box. Start by selecting the
cell or cells that you want to format and then do the following:

+ Select the Format+ Cells command.
» Right-click and choose Format Cells from the shortcut menu.

* Press the Ctrl+1 shortcut key.
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Figure 6-7: The Number tab of the Format Celis
dialog box enables you to format numbers in just
about any way imaginable.

The Number tab of the Format Cells dialog box displays 12 categories of number for-
mats from which to choose. When you select a category from the list box, the right
side of the tab changes to display appropriate options. For example, Figure 6-8 shows
how the dialog box looks when you click the Number category.
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Figure 6-8: Options for the Number category.
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The Number category has three options that you can control: the number of decimal
places displayed, whether to use a comma for the thousand separator, and how you
want negative numbers displayved. Notice that the Negative numbers list box has
four choices (two of which display negative values in red), and the choices change
depending on the number of decimal places and whether you choose to use a
comma to separate thousands. Also, notice that the top of the tab displays a

sample of how the active cell will appear with the selected number format. After you
make your choices, click OK to apply the number format to all the selected cells,
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The best way to learn about number formats is to experiment. Enter some values
on a worksheet and practice applying number formats.

The following are the number-format categories, along with some general comments:

* General: The default format; it displays numbers as integers, decimals, or in
scientific notation if the value is too wide to fit in the cell.

» Number: Enables vou to specify the number of decimal places, whether to use
a comma to separate thousands, and how to display negative numbers (with
a minus sign, in red, in parentheses, or in red and in parentheses).

» Currency: Enables you to specity the number of decimal places, whether to
use a dollar sign, and how to display negative numbers (with a minus sign, in
red, in parentheses, or in red and in parentheses). This format always uses a
comma to separate thousands.

»  Accounting: Differs from the Currency format in that the dollar signs always
line up vertically.

» Date: Enables you to choose from 15 date formats.
« Time: Enables you to choose from eight time formats.

« Percentage: Enables vou to choose the number of decimal places and always
displays a percent sign.

» Fraction: Enables you to choose from among nine fraction formats.
= Scientific: Displays numbers in exponential notation (with an E): 2.00E+05 =

200,000. 2.05E+05 = 205,000. You can choose the number of decimal places to
display to the left of E.

« Text: When applied to a value, causes Excel to treat the value as text (even if
it looks like a value). This feature is useful for items such as part numbers.

* Special: Contains four additional nurnber formats (Zip Code, Zip Code +4,
Phone Number, and Social Security Number).

+ Custom: Enables you to define custom number formats that aren’t included in
any of the other categories. Custom number formats are described in the next
section.

Figure 6-9 shows an example from each category.
if the cell displays a series of pound signs (such as ########4#), it means that

the column is not wide enough to display the value by using the number format
that you selected. Either make the column wider or change the number format.

You won't see this condition too often, because Excel usually adjusts column
widths automatically to accommodate entries as you make them.
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Refer to Chapter 11 for more information about styles.

Figure 6-9: Examples of values with various number formats.

Custom Number Formats

As mentioned in the previous section, the custom number format category enables
you to create number formats that aren’t included in any of the other categories.
Excel gives you much flexibility in creating custom number formats, but doing so
can be rather tricky. You construct a number format by specifying a series of codes.
You enter this code sequence in the Type field after you select the Custom category
on the Number tab of the Format Cells dialag box. Here's an example of a simple
number format code:

0.000
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This code consists of placeholders and a decimal point and tells Excel to display the
value with three digits to the right of the decimal place. Here'’s ancother example:

0co0o

This custom number format has five placeholders and displays the value with five
digits (no decimal point). This is a good format to use when the cell will hold a ZIP
code (in fact, this is the code actually used by the ZIP Code format in the Special
category). When you format the cell with this number format and then enter a ZIP
code such as 06604 (Bridgeport, CT), the value is displayed with the leading zero.
If you enter this number into a cell with the General number format, it displays as
6604 (no leading zero).

If yvou scroll through the list of number formats in the Custom category in the Format
Cells dialog box, you see many more examples. Most of the time, you can use one of
these codes as a starting point, and only slight customization will be needed.

Excel alsa enables yvou to specily different format codes for positive numbers,
negative numbers, zero values, and text. You do so by separating the codes with
a semicolon. The codes are arranged in the following structure:

Positive format; Negative format; Zero format; Text format

The following is an example of a custom number format that specifies a different
format for each of these types:

[Green]lGeneral;[Red]General ;[Black]General;[BluelGeneral

This example takes advantage of the fact that colors have special codes. A cell
formatted with this custom number format displays its contents in a different
color, depending on the value. In this case, positive numbers are green, negative
numbers are red, zero is black, and text is blue.

if you want to apply cell formatting automatically, such as text or background
color, based on the cell’'s contents, a better solution is to use Excel’s Conditional
Formatting feature. This feature is discussed in Chapter 11.

The following number format (three semicolons) consists of no format codes for
each part of the format structure— essentially hiding the contents of the cell:

EREEE]

Table 6-3 lists the formatting codes available for custom formats, along with brief
descriptions. These codes are described further in Excel’s online help.

Custom number formats are stored with the worksheet. To make the custom
format available in a different workbook, you must copy a cell that uses the cus-
tom format to the other workbook.
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Cade Comments

Yo Percentage

E-E+e—e+ Scientific notation

@ Text placeholder

[COLOR n] Displays the corresponding color in the color palette, where nisa
number from O to 56

Table 64 lists the codes that are used to create custom formats for dates and times.

Comiments
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Code Comments

dd Displays the day as a number with leading zeros (01 —31)

dddd u‘Dlsplays the day as a full name (Sunday— Saturday)

h or hh Displays the hour as a number without leading zeros (0— 23), or
as a number with leading zeras (00 — 23)

S Ot S8 Displays the second as a number without leading zeros (0 —59),
or as a number with leading zeros (00 —59)

AM/am/Afa/PM/pm/P/p  Displays the hour using a 12-hour dock; if no AM/PM indicator
is used, the hour uses a 24-hour clock

Figure 6-10 shows several examples of custom number formats, and the workbook is
available at this book’s Web site.

Figure 6-10: Examples of custom number formats.
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Studying these examples will help you understand the concept and may give you
some ideas for your own custom number formats,

Basic Cell Formatting

Whereas the preceding section discusses number formatting, this section discusses
some of the basic stviisfic formatting options available to you. These formatting tech-
niques apply to values, text, and formulas. The options discussed in this section are
available from the Formatting toolbar. Complete formatting options are available in
the Format Cells dialog box, which appears when you choose Format« Cells (or
press Ctrl+1).

if you display the Standard toolbar and the Formatting toolbar side by side, you
may not see many of the tools discussed in this section unless you click the arrow
at the right edge of the Formatting toolbar.

Remember that the formatting you apply works with the selected cell or cells. There-
fore, you need to select the cell (or range of cells) before applying the formatting.

The concept of worksheet stylistic formatting is discussed in detail in Chapter 11.

Alignment

When vou enter text in a cell, Excel aligns the text with the left edge of the cell.
Values, on the other hand, are displayed right-aligned in the cell.

To change the alignment of a cell’s contents, select the cell and then click the appro-
priate button on the Formatting toolbar. The relevant buttons are as follows:

» Align Left: Aligns the text to the left side of the cell. If the text is wider than
the cell, it spills over to the cell to the right. If the cell to the right is not
empty, the text is truncated and not completely visible.

» Center: Centers the text in the cell. If the text is wider than the cell, it spills
over to cells on either side, if they are empty. If the adjacent cells aren’t empty,
the text is truncated and not completely visible.

= Align Right: Aligns the text to the right side of the cell. If the text is wider
than the cell, it spills over to the cell to the left. If the cell to the left is not
empty, the text is truncated and not completely visible.

» Merge and Center: Centers the text in the selected cells and merges the cells
into one cell. This feature is described in detail in Chapter 11.
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Font and Text Size

To change the font and the size of the contents of a cell or range, select the cells
and then use the Font and Font Size tools on the Formatting toolbar. These tools
are drop-down lists. Click the arrow on the tool to display a list of fonts or font
sizes (see Figure 6-11). Then, choose the font or size that you want.

R ekl

Figure 6-11: Selecting a font from the Font list.

In Excel 2000, fonts in the Font list provide examples of the font they represent,
making it easier for you to select the correct font. You can change this default
behavior so that the Font list displays all fonts in Arial, as earlier versions of Excel
did. Choose Tools+ Customer and then click the Options tab. Remove the check
from the check box labeled List font names in their font.

Attributes

The Formatting toolbar also has buttons that enable you to make the selected cells

bold, italic, or underlined. As you might expect, clicking the appropriate tool makes
the change. These buttons actually are toggles, so if the cell is already bold, clicking
the Bold button removes the bold.

Borders

Applying a border is another type of formatting. Borders are lines drawn around
all or part of selected cells or ranges. When vyou click the Borders button on the
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Formatting toolbar, it expands to display 12 border choices in a miniature toolbar.
To find the Borders tool, you may need to click the arrow at the right edge of the
Formatting toolbar, to display the palette of extra tools (see Figure 6-12). You can
drag the toolbar’s title bar and move it anvwhere you want.

Figure 6-12: The Borders
tool on the Formatting
toolbar opens to display
12 border choices.

To add a border to the selected cell or cells, just click the icon that corresponds
to the type of border yvou want. The upper-left icon removes all borders from the
selected cells.

Normally, Excel displays gridlines to delineate cells in the worksheet. If you add
border formatting, you may want to turn off the gridline display. To do so, choose
Tools- Options, click the View tab, and then uncheck the Gridlines check box.
When you hide gridlines, you can easily see the effects of borders.

Colors

The Fill Color tool lets you quickly change the background color of the cell, and
the Font Color tool lets you change the text color. These tools are similar to the
Borders tool and also can be moved to a different location.

Data Entry Tips

This chapter wraps up with some useful tips and techniques that can make your
data entry more efficient.

Validating Data Entry

In Excel 2000, you can specify the type of data that a cell or range should hold. For
example, you might develop a spreadsheet that will be used by others. Assume that
the worksheet has an input cell that is used in a formula. This particular cell might
require a value between 1 and 12 to produce valid results in the formula. You can
use the data-validation feature to display a message if the user enters a value that
does not fall between 1 and 12.

To set up data validation, select the cell or range of cells that you want validated,
and then choose Data+s Validation. Excel displays the Data Validation dialog box,
with its three tabs (see Figure 6-13).
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Figure 6-13: The Data Validation dialog box enables you to
specify the type of data that will be entered in a cell.

» Click the Settings tab and specify the type of data that the cell should contain.
The dialog box changes, depending on your choice in the Allow box.

» Click the Input Message tab and specify a message that will appear when the
cell is selected (optional). The message appears from the Office Assistant (if
it’s displayed) or in a small pop-up box.

« Click the Error Alert tab and specify the message that will appear in a dialog
box if invalid data is entered (optional).

You can set up data validation for as many cells as vou want.

This technique isn't foolproof. The validation does not occur if the user pastes
invalid data into a cell that is set up for validation.

Move the Cell Pointer After Entering Data?

Depending on how you configure Excel, pressing the Enter key after entering data
into a cell may automatically move the cell pointer to another cell. Some users (like
myself) find this annoying; others like it. To change this setting, choose Tools «
Options and click the Edit tab. The check box that controls this behavior is labeled
Move Selection after Enter. You can als¢ specify the direction in which the cell
pointer moves (down, left, up, or right).
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Use Arrows Instead of Enter

This chapter mentions several times that vou use the Enter key when vou're
finished making a cell entry. Well, that’s only part of the story. You also can use
any of the direction keys instead of Enter. And, not surprisingly, these direction
keys send you in the direction that you indicate. For example, if you're entering
data in a row, press the right-arrow key rather than Enter. The other arrow keys
work as expected, and you can even use PgUp and PgDn.

Selecting Cells Before Entering Data

Here’s a tip that most Excel users don’t know about: If you select a range of cells,
Excel automatically moves the cell pointer to the next cell in the range when vou
press Enter. If the selection consists of multiple rows, Excel moves down the
column; when it reaches the end of the selection in the column, it moves to the
first selected cell in next column. To skip a cell, just press Enter without entering
anything. To go backward, use Shift+Enter. If you prefer to enter the data by rows
rather than by columns, use Tab rather than Enter.

If you have lots of data to enter, this technique can save vou a few keystrokes —
and ensure that the data you enter winds up in the proper place.

Use Ctrl+Enter for Repeated Information

If you need to enter the same data into multiple cells, your first inclination may be
to enter it once and then copy it to the remaining cells. Here’s a better way: Select
all the cells that you want to contain the data, enter the value, text, or formula, and
then press Ctrl+Enter. The single entry will be inserted into each cell in the
selection.

Automatic Decimal Points

If you need to enter lots of numbers with a fixed number of decimal places, Excel
has a useful tool that works like some adding machines. Select Tools+ Options and
click the Edit tab. Check the check box labeled Fixed Decimal and make sure that
it’s set for two decimal places. When the Fixed Decimal option is set, Excel supplies
the decimal points for you automatically. For example, if you enter 12345 into a cell,
Excel interprets it as 123.45 (it adds the decimal point). To restore things back to
normal, just uncheck the Fixed Decimal check box in the Options dialog box.

Changing this setting doesn’t affect any values that you have already entered.

CiM Ex. 1051 Page 155



Using AutoFill

Excel’s AutoFill feature makes it easy to insert a series of values or text items in
a range of cells. [t uses the AutoFill handle (the small box at the lower left of the
active cell). You can drag the AutoFill handle to copy the cell or automatically
complete a series.

Chapter 7 discusses AutoFill in detail.

Using AutoComplete

With AutoCormplete, you type the first few letters of a text entry into a cell, and Excel
automatically completes the entry, based on other entries that you've already made
in the column. If your data entry task involves repetitious text, this feature is for you.

Here'’s how it works. Suppose that you're entering product information in a column.
One of your products is named Widgets. The first time that you enter Widgets into

a cell, Excel remembers it. Later, when you start typing Widgets in that same column,
Excel recognizes it by the first few letters and finishes typing it for you. Just press
Enter and you're done. It also changes the case of letters for you automatically. If
you start entering widget (with a lowercase w) in the second entry, Excel makes the
w uppercase, to be consistent with the previous entry in the column.

Besides reducing typing, this feature also ensures that vour entries are spelled
correctly and are consistent.

You also can access a mouse-oriented version of this feature by right-clicking the
cell and selecting Pick from List from the shortcut menu. With this method, Excel
displays a drop-down box that has all the entries in the current column; just click
the one that you want.

If vou find the AutoComplete feature distracting, you can turn it off on the Edit tab
of the Options dialog box. Remove the check mark from the check box labeled
Enable AutoComplete for Cell Values.

Entering the Current Date or Time into a Cell

Sometimes, vou need to date-stamp or time-stamp your worksheet. Excel provides
two shortcut keys that do this for you:

» Current date: Ctrl+; (semicolon)

« Current time: Ctrl-Shift+; (semicolon)
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Forcing a New Line in a Cell

If vou have lengthy text in a cell, you can force Excel to display it in multiple lines
within the cell. Use Alt+Enter to start a new line in a cell. Figure 6-14 shows an
example of text in a cell that is displayed in multiple lines. When you add a line
break, Excel automatically changes the cell’s format to Wrap Text.

Learn more about the Wrap Text formatting feature in Chapter 11.

Figure 6-14: Alt+Enter enables you to force a line break
in a cell.

Entering Fractions

[f you want Excel to enter a fraction into a cell, leave a space between the whole
number and the fraction. For example, to enter the decimal equivalent of 67/s,
enter 68 7/8 and then press Enter. When you select the cell, 6.875 appears in the
formula bar, and the cell entry appears as a fraction. If vou have a fraction only
(for example, 1/8), you must enter a zero first, like this: 0 1/8. When you select the
cell and look at the formula bar, vou see 0.125. In the cell, you see l/g,

Using a Data Entry Form

If you're entering data that is arranged in rows, you may find it easier to use Excel’s
built-in data form for data entry, Figure 6-15 shows an example of this.
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Start by defining headings for the columms in the first row of your data entry range.
You can always erase these entries later if yvou don’t need them. Excel needs headings
for this command to work, however. Select any cell in the header row and choose
Data* Form. Excel asks whether you want to use that row for headers (choose OK).
Excel then displays a dialog box similar to the one shown in Figure 6-15. You can use
Tab to move between the text boxes and supply information. When you complete the
data form, click the New button. Excel dumps the data into a row in the worksheet
and clears the dialog box for the next row of data.

This data form feature has many other useful buttons, which are discussed further
in Chapter 23.

Customers

Figure 6-15: Excel’s built-in data form can
simplify many data entry tasks.

Using AutoCorrect for Data Entry

You can use Excel’s AutoCorrect feature to create shortcuts for cormmmmonly used
words or phrases. For example, if yvou work for a company named Consolidated
Data Processing Corporation, you can create an AutoCorrect entry for an abbrevia-
tion, such as c¢dp. Then, whenever vou type cdp, Excel automatically changes it to
Consolidated Data Processing Corporation.

You can customize the AutoCorrect feature by using the Tools+ AutoCorrect com-
mand. Check the option labeled Replace text as you type, and then enter your
custom entries (Figure 6-16 shows an example). You can set up as many custom
entries as you like.
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Figure 6-16: You can use Excel's AutoCarrect
feature to set up keyboard shortcuts.

Summary

A worksheet cell can contain a value, text, or a formula. This chapter focuses on
the task of entering values and formulas. It explains Excel’s method of dealing with
dates and times and introduces the concept of number formatting — which makes
numbers appear differently, but doesn’t affect their actual value. This chapter also
discusses common editing techniques and basic stylistic formatting, and
concludes with a series of general data entry tips.
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Essential
Spreadsheet
Operations

I his chapter discusses the common spreadsheet
operations that you need to know. A thorough knowledge
of these procedures will help you to work more efficiently.

Working with Worksheets

When you open a new workbook in Excel, the workbook has a
designated number of worksheets in it. You can specify how
many sheets each new workbook will contain. By default, this
number of worksheets is three. Although empty worksheets
really don’t use much additional memory or disk storage
space, they just get in the way. And besides, adding a new
worksheet when you need one is easy. | strongly recommend
that you change the default value to one worksheet. To do so,
select Tools+ Options, select the General tab, and then
change the Sheets in new workbook setting to one. After doing
this, all new workbooks will have a single worksheet.

You may find it helpful to think of a workbook as a notebook
and worksheets as pages in the notebook. As with a notebook,
you can activate a particular sheet, add new sheets, remove
sheets, copy sheets, and so on. The remainder of this section
discusses the operations that you can perform with
worksheets.
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Figure 7-12: You can easily lose your bearings when the row
and column headers scroll out of view.

Figure 7-13 shows the worksheet from the previous figure, but with frozen panes. In
this case, row 1 and colunm A are frozen in place. This keeps the headings visible
while you are scrolling through the worksheet.

Observations.xls

i September
iBranch 85 G 822
13
440
94

L Branch 91
Branch 92

frozen in place.

To freeze panes, start by moving the cell pointer to the cell below the row that
you want to [reeze and to the right of the column that you want to freeze. Then,
select Window * Freeze Panes. Excel inserts dark lines to indicate the frozen rows
and columns. You'll find that the frozen row and column remain visible as you
scroll throughout the worksheet. To remove the frozen panes, select Window «
Unfreeze Panes.
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Working with Rows and Columns

Every worksheet has exactly 65,536 rows and 256 columns. A nice feature would be
the capability to specify the number of rows and columns for each worksheet, but
these values are fixed and you can’t change them. This section discusses some
worksheet operations that involve rows and columns.

Inserting Rows and Columns

Although the number of rows and columns in a worksheet is fixed, you can still
insert and delete rows and columns. These operations don’t change the number of
rows or columms. Rather, inserting a new row moves down the other rows to
accommodate the new row. The last row is simply removed from the worksheet, if it
is empty. Inserting a new column shifts the columns to the right, and the last
column is removed, if it's empty.
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Working with
Cells and Ranges

I his chapter discusses a variety of techniques that you
use to work with cells and ranges.

Cells and Ranges

A cell is a single element in a worksheet that can hold a value,
text, or a formula. A cell is identified by its address, which
consists of its column letter and row number. For example,
cell D12 is the cell in the fourth column and the twelith row.

A group of cells is called a range. You designate a range address
by specifying its upper-left cell address and its lower-right cell
address, separated by a colon.

Here are some examples of range addresses:

Al:B1

C24
Al:A100
Al:D416
C1:C65536

AG6:IV6

A1:IV65536

Two cells that occupy one row and two
columns

A range that consists of a single cell
100 cells in column A
Cells (four rows by four columns)

An entire column of cells; this range
also can be expressed as C:C

An entire row of cells; this range also
can be expressed as 6:6

All cells in a worksheet
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When you're simply navigating through a worksheet or formatting cells, you don't
really need to know the range address with which you're working. Understanding
cell addresses is most important when you are creating formulas, as you'll see in
the next chapter.

Selecting Ranges

To perform an operation on a range of cells in a worksheet, you must select the
range of cells first. For example, if you want to make the text bold for a range of
cells, you must select the range and then click the Bold button on the Formatting
toolbar (or, use any of several other methods to make the text bold).

When you select a range, the cells appear highlighted in light blue-gray. The

exception is the active cell, which remains its normal color. Figure 8-1 shows an
example of a selected range in a worksheet.
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Displaying a selected range in light blue-gray is a departure from the behavior of
prior versions of Excel, in which the shading of selected cells was black. Microsoft
calls this new behavior “See-through View,” and it makes it easier to see the actual
color formatting of selected cells.

T sue USRS R
Figure 8-1: When you select a range, it appears highlighted,
but the active cell within the range is not highlighted.

You can select a range in several ways:
» Use the mouse to drag, highlighting the range. lIf you drag to the end of the
screen, the worksheet will scroll.
* Press the Shift key while vou use the direction keys to select a range.

* Press F8 and then move the cell pointer with the direction keys to highlight
the range. Press F8§ again to return the direction keys to normal movement.

« Use the Edit+ Go To command (or press FB) and enter a range’s address
manually into the Go To dialog box., When you click OK, Excel selects the cells
in the range that vou specified.

As you're selecting a range, Excel displays the number of rows and columns in
your selection in the Name box (located on the left side of the formula bar).

Selecting Complete Rows and Columns

You can select entire rows and columns in much the same manner as you select
ranges, as follows:
= Click the row or column border to select a single row or column.

» To select multiple adjacent rows or columns, click a row or column border
and drag to highlight additional rows or columns.

» To select multiple (nonadjacent) rows or columns, press Ctrl while you click
the rows or columns that you want.

« Press Ctrl+spacebar to select a column. The column of the active cell (or
columns of the selected cells) will be highlighted.
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« Press Shift+spacebar to select a row. The row of the active cell (or rows of the
selected cells) will be highlighted.

» Click the Select All button {or Ctrl+Shift+spacebar) to select all rows.
Selecting all rows is the same as selecting all columns, which is the same as
selecting all cells.

Selecting Noncontiguous Ranges

Most of the time, the ranges that you select will be contiguous — a single rectangle
of cells. Excel also enables you to work with noncontiguous ranges, which consist of
two or more ranges (or single cells) that are not necessarily next to each other. This
is also known as a multiple selection. If you want to apply the same formatting to
cells in different areas of vour worksheet, one approach is to make a multiple
selection. When the appropriate cells or ranges are selected, the formatting that
you select is applied to them all. Figure 82 shows a noncontiguous range selected
in a worksheet.

_ Febd

11 566
20419
77739
109824

85310
16,208
82,701

26041 3 973 60/ MEEENEE

Figure 8-2: Excel enables you to select noncontiguous ranges, as shown here.

You can select a IlOllCOl’ltigllOuS range in several wWays:

« Hold down Ctrl while you drag the mouse to highlight the individual cells or
ranges.

* From the keyboard, select a range as described previcusly (using F8 or the
Shift key). Then, press Shift+F8 to select another range without canceling the
previous range selections.

» Select Edit* Go To and then enter a range’s address manually into the Go To
dialog box. Separate the different ranges with a comma. When you click OK,
Excel selects the cells in the ranges that you specified (see Figure 8-3).
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Figure 8-3: Enter a noncontiguous range by separating the ranges with a
comma. This example selects a noncontiguous range made up of two
ranges: B2:C9 and E2:EQ.

Selecting Multisheet Ranges

So far, this discussion has focused on ranges on a single worksheet. As you know,
an Excel workbook can contain more than one worksheet. And, as you might
expect, ranges can extend across multiple worksheets. You can think of these as
three-dimensional ranges.

Suppose that vou have a workbook set up to track expenses by department. A
common approach is to use a separate worksheet for each department, making it
easy to organize the data. You can click a sheet tab to view the information for a
particular department.

Figure 84 shows a workbook that has four sheets, named Total, Marketing,
Operations, and Manufacturing. The sheets are laid out identically. The anly
difference is the values. The Total sheet contains formulas that compute the sum of
the corresponding items in the three departmental worksheets.
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Figure 8-4: A sample workbook that uses multiple worksheets.

The worksheets in the Department Budget Summary workbook aren’t formatted in
any way. If you want to apply number formats, for example, one (not so efficient)
approach is simply to format the values in each worksheet separately. A better
technique is to select a multisheet range and format the cells in all the sheets
simultaneously. The following is a step-by-step example of multisheet formatting,
using the workbook shown in Figure 8-4.

1. Activate the Total workshest.
2. Select the range BZ:E6.

3. Press Shift and click the sheet tab labeled Manufacturing. This selects all
worksheets between the active worksheet (Totals) and the sheet tab that you
click—in essence, a three-dimensional range of cells (see Figure 85). Notice
that the workbook window's title bar displays [Group]. This is a reminder that
you've selected a group of sheets and that you're in Group edit made.

4. Click the Comma Style button on the Formatting toolbar. This applies comma
formatting to the selected cells.

B. Click one of the other sheet tabs, This selects the sheet and also cancels
Group mode; [Group] is no longer displayed in the title bar.

Quartar 1 Quarter 2 Quarter 3 Quarter 4

SEEG00 SE5000 SAE0A0 5985000,
10400 11400 <0400 11200,
4E0CD 48000 45000 450001
@400 30400 G40

idacenn i081E00 161600

h Total ¢ Marketing  Operations ¢ fﬂanufa;g[’[;g__gﬂﬁégi

Figure 8-5: Excel in Group mode, with a three-dimensional range
of cells selected.

Excel applied comma formatting to all of the values in the selected sheets.
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In general, selecting a multisheet range is a simple two-step process: select the
range in one sheet and then select the worksheets to include in the range. To select
a group of contiguous worksheets, vou can press Shift and click the sheet tab of the
last worksheet that you want to include in the selection. To select individual work-
sheets, hold down Ctrl and click the sheet tab of each worksheet that you want to
select. If all the worksheets in a workbook aren’t laid out the same, you can skip the
sheets that vou don’t want to format. When you make the selection, the sheet tabs
of the selected sheets appear in reverse video, and Excel displays [Group] in the
title bar.

To select all sheets in a workbook, right-click any sheet tab and choose Select All
Sheets from the shortcut menu.

Special Selections

The Edit+ Go To command (or F5) was mentioned earlier as a way to select {or go
to) a cell or range. Excel also provides a way to select only “special” cells in the
workbook or in a selected range. You do this by choosing Edit+ Go To, which
brings up the Go To dialog box. Clicking the Special button displays the Go To
Special dialog box, shown in Figure 86.

Figure 8-6: The Go To Special dialog box enables you to select specific types of cells.
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After you make your choice in the dialog box, Excel selects the qualifying subset of
cells in the current selection. Usually, this results in a multiple selection. If no cells
qualify, Excel lets vou know.

if you bring up the Go To Special dialog box with only one cell selected, Excel
bases its selection on the entire active area of the worksheet.

Table 8-1 offers a description of the options available in the Go To Special dialog
box. Some of the options can be quite useful.

Gption What It Does

Constants Selects all nonempty cells that don't contain formulas. This option
is useful if you have a model set up and want to clear out all
input cells and enter new values. The formulas remain intact.

Blanks Selects all empty cells.

Current Array Selects the entire array. Arrays are covered in Chapter 20.

Row Differences Analyzes the selection and selects cells that are different from
other cells in each row. Ctrl+\ is the shortcut.

Precedents Selects cells that are referred to in the formulas in the active cell
or selection. You can select either direct precedents or precedents
at any level.

Last Cell Selects the baottom-right cell in the worksheet that contains data
or formatting. Ctrl+End is the shortcut.
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Option What It Does

Conditional Formats Selects cells that have a conditional format applied (using the

Format+ Conditional Formatting command).
"

Annotating a Cell

Excel’s cell.comment feature enables you to attach a comment to a cell. This feature
is useful when you need to document a particular value. It’s also useful to help you
remember what a formula does.

In versions of Excel prior to Excel 97, cell comments were known as cell notes.

To add a comment to a cell, select the cell and then choose Insert« Comment
(or Shift+F2). Excel inserts a comment that points to the active cell, as shown in
Figure 8-7. Initially, the comment consists of your name. Enter the text for the cell
comment and then click anywhere in the worksheet to hide the comment.

Depantment Budget Summary.xls

Quarter 1 ‘Quarter 2 |Quarte
490000°"" Tahn walkenbach;.

2200 The salary figures are

19200 ook finalzed v -
22800 i
533600

R D anuracturing ARSI u@iﬁ?@é

Figure 8-7: Excel enables you to add a descriptive note to a cell.

Cells that have a comment attached display a small red triangle in the upper-right
corner. When you move the mouse pointer over a cell that contains a comment, the
comment becomes visible.

Select Tools« Options (View tab) to control how cell comment indicators are
displayed. You can turn off these indicators if you like.
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If vou want all cell comiments to be visible (regardless of the location of the cell
pointer), select View+s Comments. This command is a toggle; select it again to hide
all cell comments. To edit a comment, activate the cell, right-click, and then choose
Edit Comment from the shortcut menu.

To delete a cell comment, activate the cell that contains the comment, right-click,
and then choose Delete Comment from the shortcut menu.

Deleting Cell Contents

To erase cells by using only the mouse, select the cell or range ta be deleted. Then,
click the fill handle —the small square to the lower right of the selection indicator
(see Figure 8-8). When vou move the mouse pointer over the fill handle, the pointer
changes to a cross. As you drag up, Excel grays out the selection. Release the
mouse button to erase the contents of the grayed selection.

To erase the contents of a cell or range, select the cell or range and press Delete.
}?ﬁ@ Or, you can select Edit+ Clear, which provides additional options.

N

handle up to erase cell contents by using the mouse.
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Figure 8-
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Copying a Range

Copying the contents of a cell is a very common operation. You can do any of the
following:

» Copy a cell to another cell.

* Copy a cell to a range of cells. The source cell is copied to every cell in the
destination range.

» Copy arange to ancother range. Both ranges must be the same size.

Copying a cell normally copies the cell contents, any formatting that is applied to
the original cell {(including conditional formatting and data validation), and the cell
comment (if it has one). When you copy a cell that contains a formula, the cell ref-
erences in the copied formulas are changed automatically to be relative to their
new destination. Mare on this in the next chapter.

Copying consists of two steps (although shortcut methods exist, as you'll see later):

1. Select the cell or range to copy (the source range) and copy it to the
Cliphoard.

2. Move the cell pointer to the range that will hold the copy (the destination
range) and paste the Clipboard contents.

When you paste information, Excel overwrites — without warning — any cells that
get in the way. If vou find that pasting overwrote some essential cells, choose Edit+
Undo (or press Ctrl+Z).

Because copying is used so often, Excel provides many different methods. [ discuss
each method in the following sections.

Copying by Using Toolbar Buttons

The Standard taolbar has two buttons that are relevant to copying: the Copy button
and the Paste button. Clicking the Copy button transfers a copy of the selected cell
or range to the Windows Clipboard and the Office Clipboard. After performing the
copy part of this operation, select the cell that will hold the copy and click the
Paste button.

If you're copying a range, you don’t need to select an entire range before clicking
the Paste button. You need only activate the upper-left cell in the destination range.

if you click the Copy button more than once befare you click the Paste button,
Excel automatically displays the Office Clipboard toolbar.
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Copying by Using Menu Commands
If you prefer, you can use the following menu commands for copying and pasting:
« Edit+ Copy: Copies the selected cells to the Windows Cliphoard and the
Office Clipboard
» Edit* Paste: Pastes the Windows Clipboard contents to the selected cell

or range

You'll learn more about pasting the contents of the Office Clipboard later in this
chapter.

Copying by Using Shortcut Menus

You also can use the Copy and Paste commands on the shortcut menu, as shown in
Figure 8-9. The Copy command on the shortcut menu places information on bhoth
the Windows and Office Clipboards. Select the cell or range to copy, right-click, and
then choose Copy from the shortcut menu. Then, select the cell in which you want
the copy to appear, right-click, and choose Paste from the shortcut menu.
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Figure 8-9: Right-clicking anywhere on the screen displays a shortcut menu, which
contains Copy and Paste commands.

Copying by Using Shortcut Keys

The copy and paste operations also have shortcut keys associated with them:

« Ctrl+C: Copies the selected cells to both the Windows and Olffice Clipboards

« Crl+V: Pastes the Windows Clipboard contents to the selected cell or range

These shortcut keys also are used by most other Windows applications.

| Copying by Using Drag and Drop

Excel also enables you to copy a cell or range by dragging. Be aware, however, that
dragging and dropping does rot place any information on either the Windows
Clipboard or the Office Clipboard. Select the cell or range that you want to copy
and then move the mouse pointer to one of its four borders. When the mouse
pointer turns into an arrow pointing up and to the left, press Ctrl; the mouse
pointer is augmented with a small plus sign. Then, simply drag the selection to its
new location, while you continue to press the Ctrl key. The original selection
remains behind, and Excel makes a new copy when you release the mouse button.
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if the mouse pointer doesn't turn into an arrow when you point to the border of a
cell or range, you need to make a change to your settings. Select Toals« Options,
click the Edit tab, and place a check mark on the option labeled Allow cell drag
and drop.

Copying to Adjacent Cells

Often, you'll find that you need to copy a cell to an adjacent cell or range. This type
of copying is quite common when working with formulas. For example, if you're
working on a budget, you might create a formula to add the values in column B. You
can use the same formula to add the values in the other columns. Rather than
reenter the formula, youw’ll want to copy it to the adjacent cells.

Excel provides some additional options on its Edit menu for copying to adjacent
cells. To use these commands, select the cell that you're copying and the cells that
you are copying to (see Figure & 10). Then, issue the appropriate command from
the following list for one-step copying:

« Edit~ Fill* Down (or Cixl+D): Copies the cell to the selected range below

« Edite Fill+ Right (or Crl+R): Copies the cell to the selected range to the right

+ Edit+ Fill+ Up: Copies the cell to the selected range above

« Edit+ Fill+ Left: Copies the cell to the selected range to the left

None of these commands places information on either the Windows Clipboard or
the Office Clipboard.

2 Department Eud(jet Summary., xls . )
Quarter 2 Quarter 3 CQuarter 4
375000 375000
3200 } 3200
25000 0 25000

Operations

Figure 8-10: To copy to adjacent cells, start by selecting the cell to
copy plus the cells in which you want the copy to appear.

You also can use AutoFill to copy to adjacent cells by dragging the selection’s fill
handle. Excel copies the original selection to the cells that you highlight while
dragging. AutoFill doesn’t place any information on either the Windows Clipboard
or the Office Clipboard.
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Copying a Range to Other Sheets

The copy procedures described previously also work to copy a cell or range to
another worksheet, even if the worksheet is in a different workbook. You must, of
course, activate the other worksheet before you select the location to which you
want to copy.

Excel offers a quicker way to copy a cell or range and paste it to other worksheets
in the same workbook. Start by selecting the range to copy. Then, press Ctrl and
click the sheet tabs for the worksheets to which you want to copy the information
(Excel displays [Group] in the workbook’s title bar). Select Edit+ Fill* Across
Worksheets, and a dialog box appears that asks what you want to copy (All,
Contents, or Formats). Make your choice and then click OK. Excel copies the
selected range to the selected worksheets; the new copy will occupy the same
cells in the selected worksheets as the original occupies in the initial worksheet.

Be careful with this command, because Excel doesn’t warn you if the destination
cells contain information. You can quickly overwrite lots of information with this
command and not even realize it.

Moving a Cell or Range

Copying a cell or range doesn’t modify the cell or range that you copied. If you want
to relocate a cell or range to another location, you’ll find that Excel is also quite
accommodating.

Recall that the Edit+ Copy command makes a copy of the selected cell or range
and puts the copy on the Windows Clipboard and the Office Clipboard. The Edit«
Cut command also places the selection on both Clipboards, but the Edits Cut
command also removes the contents of the selection from its original location.
To move a cell or range, therefore, requires two steps:

1. Select the cell or range to cut (the source range) and “cut” it to both of the
Clipboards.

2, Select the cell that will hold the moved cell or range (the destination range)
and paste the contents of one of the Clipboards. The destination range can be
on the same worksheet or in a different worksheet— or in a different
workbook.

You also can move a cell or range by dragging it. Select the cell or range that you
want to move and then slide the mouse pointer to any of the selection’s four bor-
ders. The mouse pointer turns into an arrow pointing up and to the left. Drag the
selection to its new location and release the mouse button. This option is similar to
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copying a cell, except that you don’t press Ctrl while dragging; when you drag by
moving, you don’t place any information on either the Windows Clipboard or the
Office Clipboard.

Other Cell and Range Operations

As yvou know, the Edits Copy command and the Edit+ Cut command place
information on both Cliphoards. Similarly, the Edit+ Paste command transfers the
contents of the Windows Clipboard to the selected location in your worksheet.

Excel contains two more versatile ways to paste information. You can use the Office
Clipboard to copy and paste multiple items, or you can use the Paste Special dialog
box to paste information in distinctive ways.

Using the Office 2000 Clipboard to Paste

As mentioned earlier in this chapter, Office 2000 presents a new clipboard, the
Office Clipboard, which is available only in Office programs. Whenever you cut or
copy information in an Office program, such as Excel, the program places the
information on both the Windows Clipboard and the Office Clipboard. However,
the program treats information on the Office Clipboard differently than it treats
information on the Windows Clipboard. Instead of replacing information on the
Oftfice Clipboard, the program appends the information to the Office Clipboard.
With multiple items stored on the Clipboard, you can then paste the items either
individually or as a group.

So far in this chapter, vou've seen many ways to copy and cut information to both
clipboards. Each of these techniques, however, pastes information from the
Windows Clipboard, not the Office Clipboard. When would yvou use the Office
Clipboard? When you want to store multiple items on the Office Clipboard and
selectively paste them. Or, when vou want to store multiple items on the Office
Clipboard and paste them all simultaneously.

The Office toolbar is available in aff Office programs. Suppose that you have stored
some items from Excel, Access, Qutlook, PowerPoint, and Word on the Office
Clipboard. You can switch to Excel and paste some or all the items from Access.
And, you can switch to Word and paste some or all the items from both
PowerPoint and Excel.

Suppose that you've created a worksheet like the one shown in Figure 8-11. You
have sales, expense, and net information for each individual city stored on the
“city” sheets (Denver, San Diego, New York, and Chicago). You want to copy the
information from the “city” sheets to the summary sheet, so that you can total the
information. In earlier versions of Excel, this task would have been quite tedious.
With the Office Clipboard, the task is easy.
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Figure 8-11: Use the Office Clipboard to copy information from the “city” sheets to
the summary sheet.

The process still consists of two basic steps: copy a selection and then paste it.
However, when vou use the Office Clipboard, you copy several times before you
paste.

Select the first cell or range that you want to copy to the Office Clipboard and copy
it by using any of the techniques described earlier in this chapter: Click the Copy
tool on the Standard toolbar; choose Edite Copy; press Ctrl+C; or right-click to
choose Copy from the shortcut menu.

Repeat this process, selecting the next cell or range that you want to copy. As soon
as you copy the information, the Office Clipboard toolbar appears, showing you the
number of items that you've copied (see Figure 8-12). The Office Clipboard will hold
up to 12 items; when vou try to add a thirteenth item, you'll see a message asking
whether vou want to remove the first item that you copied or cancel copying the
thirteenth item. Each item stored on the Office Clipboard toolbar contains the
symbol for the program from which you copied it; if you point at one of the icons,
you'll see a toolbar tip showing you a sample of the information that the item
contains.
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You can display the Office Clipboard toolbar either by clicking the Copy tool twice,
without pasting, or by choosing View+ Toolbars+ Clipboard.

Figure 8-12: The Office Clipboard toolbar displays icons representing each item
that you copy.

If necessary, continue copying information. If you want, you can use the Copy tool
on the Office Clipboard toolbar; it serves the same purpose and functions in the
same way as the Copy tool on the Standard toolbar.

When you're ready to paste information, select the cell into which you want to copy
information. To paste an individual item, click its icon on the Office Clipboard toolbar.
To paste all the items that you've copied, click the Paste All button on the Office
Clipboard toolbar.

Although the items appear “across” the Office Clipboard, Excel pastes them down
a column when you click Paste All —even if you select a range before you click
Paste All

You can clear the contents of the Office Clipboard by clicking the Clear Clipboard
tool.

Some special notes about the Office Clipboard and its functioning:
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« Excel pastes the contents of the Windows Clipboard when you paste either by
clicking the Paste toal an the Standard toolbar, by choosing Edit+ Paste, by
pressing Ctrl+V, or by right-clicking to choose Paste from the shortcut menu.

« The last item that you cut or copied appears on both the Office Clipboard and
the Windows Clipboard.

» Pasting from the Office Clipboard places that item on the Windows Clipboard.
If you choose Paste All from the Office Clipboard toolbar, you paste all items
stored on the Office Clipboard onto the Windows Clipboard as a single item.

+ C(learing the Office Clipboard also clears the Windows Clipboard.

Pasting in Special Ways

The Edit+ Paste Special command is a much more versatile version of the Edit «
Paste command. For the Paste Special command to be available, you need to copy
a cell or range to the Clipboards (using Edit+ Cut won’t work). Then, select the
cell in which you want to paste, and choose Edit+ Paste Special. You see the
dialog box shown in Figure 8-13. This dialog box has several options, which are
explained in the following sections.

ek SE

Figure 8-13: The Paste Special dialog box.
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Pasting all

Selecting the All option in the Paste Special dialog box is equivalent to using the
Edit» Paste command. [t copies the cell’s contents, formats, and data validation
from the Windows Clipboard.

Pasting farmulas as values

Normally, when you copy a range that contains formulas, Excel copies the formulas
and automatically adjusts the cell references. The Values option in the Paste Special
dialog box enables you to copy the results of formulas. The destination for the copy
can be a new range or the original range. In the latter case, Excel replaces the
original formulas by their current values.

Pasting cell formats only

If you've applied formatting to a cell or range, you can copy only the formatting and
paste it to another cell or range. If you've applied lots of formatting to a cell and
want to duplicate the formatting elsewhere, use the Formats option in the Paste
Special dialog box to save a great deal of time.

Pasting cell comments

If you want to copy only the cell comments from a cell or range, use the Comments
option in the Paste Special dialog box. This option doesn’t copy cell contents or
formatting.

Pasting validation criteria

If you've created validation criteria for a particular cell (by using the Data«
Validation command), you can copy the validation criteria to another cell or range.
Use the Validation option in the Paste Special dialog box.

Skipping borders when pasting

Often, vou’ll want to avoid copying borders around a cell. For example, if you have
a table with a barder around it, copying a cell from one of the outer cells in the
table will also copy the border. To avoid pasting the border, choase the All except
borders option in the Paste Special dialog box.

Pasting column widths

You can copy column width information from one column to another. Copy any cell
in the column that is set at the width that you want to copy. Select a cell in the
column whose width you want to set. [n the Paste Special dialog box, choose the
Column widths option button.

Performing mathematical operations without Formulas

The option buttons in the Operation section of the Paste Special dialog box let you
perform an arithmetic operation. For example, you can copy a range to another
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range and select the Multiply operation. Excel multiplies the corresponding values
in the source range and the destination range and replaces the destination range
with the new values,

Figure 8-14 shows another example of using a mathematical operation with the
Paste Special dialog box. The objective of this example is to increase the values in
B4:B10 by ten percent (without using formulas). First, the contents of cell Bl were
copied to the Clipboard. Then, B4:B10 was selected and the Edit* Paste Special
command was issued. Choosing the Multiply operation causes each cell in B4:B10
to be multiplied by the value on the Clipboard, effectively increasing the cell values
by ten percent. You also need to select the Value option — otherwise, the cells take
on the formatting of the pasted cell.

Figure 8-14: Using the Paste Special command
to increase the values in a range by ten percent.

Skipping blanks when pasting

The Skip Blanks option in the Paste Special dialog box prevents Excel from
overwriting cell contents in your paste area with blank cells from the copied range.
This option is useful if vou're copying a range to another area, but don’t want the
blank cells in the copied range to overwrite existing data.

Transposing a range

The Transpose option in the Paste Special dialog box changes the orientation of the
copied range. Rows become columns and columns become rows. Any formulas in
the copied range are adjusted so that they work properly when transposed. Note
that this check box can be used with the other options in the Paste Special dialog
box. Figure 815 shows an example of a horizontal range that was transposed to a
vertical range.
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Figure 8-15: The range in A1:E2 was transposed to A4:B8.

Naming Cells and Ranges: The Basics

Dealing with cryptic cell and range addresses can sometimes be confusing (this
becomes even more apparent when vou deal with formulas, which are covered in
the next chapter). Fortunately, Excel enables you to assign descriptive names to
cells and ranges. For example, you can give a cell a name such as Interest_Rate, or
you can name a range JulySales. Working with these names (rather than cell or

range addresses) has several advantages, which are described next.

Advantages of Using Names

The following are a few advantages of using names:

A meaningful range name (such as Total_Income ) is much easier to remember
than a cell address (such as AC21).

Entering a name is less error-prone than entering a cell or range address.

You can quickly move to areas of your worksheet either by using the Name
box, located at the left side of the formula bar {click the arrow to drop down a
list of defined names) or by choosing Edit« Go To (or F5) and specifying the
range name.

When you select a named cell or range, the name appears in the Name box.

Creating formulas is easier. You can paste a cell or range name into a formula
either by using the Insert«+ Name+ Paste command or by selecting a name
from the Name box.

Names make your formulas more understandable and easier to use. A formula
such as =Income-Taxes is more intuitive than =D20-D40.

Macros are easier to create and maintain when you use range names rather
than cell addresses.

CiM Ex. 1051 Page 200



